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There’s no mistaking it. Summer is almost here, and
there is no shortage of volatile late Spring weather in
the central parts of the United States. The recent
large outbreak of tornadoes in the central parts of
the U.S. have punctuated the news and lives of
many people. In a one week period at the end of
May, over 100 tornadoes have erupted from the
thunderstorms that commonly roar across the plains.
Tornado outbreaks have occurred from Texas to
Minnesota, and from western Kansas to the Ohio
River Valley.
I live in Independence,
Missouri, near the
geographical center of the
country. Assistant Editor
Meemaw lives in Southeastern
Kansas, about three hours
south of my location.
Phornecker lives in Northwest
Indiana. Georgetoon lives in
the Ohio River Valley. Texstar,
ms_meme and Dragynn live in
Texas. Djohnston lives in
Oklahoma. Many PCLinuxOS
users live near – or in – areas affected by the recent
tornado outbreaks.
In fact, if you live in this area of the United States,
commonly referred to as “tornado alley,” it’s hard to
find someone who either doesn’t know someone
affected by the destruction brought by the tornadoes,
or who isn’t affected directly, themselves. Personally,
areas of my wife’s home town, Sedalia, MO, have
suffered the effects of an EF2 tornado (tornados are
rated on the Enhanced Fujita Scale, from zero for
cyclonic wind speeds up to 85 mph, to five for
cyclonic wind speeds over 200 mph). Thankfully, all

of her relatives and friends escaped any direct
damage or injury. On that particular day (May 25),
there were no fewer than 10 tornado warnings,
some of them simultaneous, dotted all around my
location.

A little further from me, but closer to Meemaw,
Joplin, MO has had the national and international
news spotlight thrust upon it, after an EF5 tornado
tore a one mile wide swath, six miles long, through
the middle of that Missouri town of 50,000 people
(it’s estimated that Joplin’s “population” swells to
270,000 during the day, when people in outlying
areas commute into Joplin for jobs and commerce).
One of my coworkers at the hospital also works at
the hospital in Joplin, MO that sustained a direct hit
by the large tornado. This particular tornado took the
lives of over 120 people, and left a path of
destruction that will cost millions of dollars to
overcome, while leaving a large number of people
homeless and their lives torn apart.
Already, 2011 is the seventh most deadly year, in
regards to deaths (501 as of May 25) from
tornadoes, and the second most deadly year since
NOAANWS has started keeping records in the early
1950s. The bad thing is that it’s not over, yet. There
will be more severe weather as the year continues,
and the death toll will undoubtedly – and
unfortunately – climb.
I know a lot of people may be asking “why do you
live in that area of the country, with these destructive
and unpredictable storms?” It’s not an easy question
to answer. First of all, it’s home. For many of us, it’s
where we were born. The rest moved here for jobs,
or because our spouses are originally from the area.
Secondly, where are you going to go? Every area, it
seems, has its share of natural disasters. California
has earthquakes and wildfires. Residents of the Gulf
of Mexico endure hurricanes. Northeastern U.S.
residents have to suffer through horrific winters and
blizzards. No matter where you go, it seems that

St. John’s Hospital, Joplin, MO, before and after the EF5
tornado on May 21, 2011. The hospital sustained a direct
hit by the tornado. Photo credit: NOAA.

Welcome From The Chief EditorWelcome From The Chief Editor
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there is some sort of natural disaster just waiting to
spring forth when the conditions are right.
Normally, I make a plea for donations to PCLinuxOS,
to help support the continued development of our
favorite Linux distro. Certainly, you should continue
to do that. But if you have any extra, donations to
either the American Red Cross or the Salvation
Army, both of whom are omnipresent and offering
assistance in times of crisis, would go a long way to
helping provide relief to those who’s lives have been
disrupted.
Until next month, I wish each and every one of you
peace, tranquility, serenity and prosperity.

Screenshot ShowcaseScreenshot Showcase

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

Welcome From The Chief Editor

Posted by aguila, May 3, 2011, running KDE4.

http://twitter.com/iluvpclinuxos
http://www.linuxconfig.org
http://www.redcross.org/
http://www.salvationarmyusa.org/
http://www.salvationarmyusa.org/
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by Archie Arevalo (Archie)

Not too long ago for many iPhone users, Linux had
been a bad mix. However, leaps and bounds in
progress to the project, libimobiledevice, has given
us Linux users breakthroughs, rather than
workarounds, and brought iPhone users, such as
myself, much closer to a Linuxonly solution. Until
early this year, the only way I could sync my music
and photo library to my iPhone was via a VirtualBox
guest XP and iTunes. I also have an iPod Classic
160 GiB Black, and I have no problem with it on
Linux. The XP virtual machine, along with iTunes,
has been deleted from my computer, thus making
my laptop 100% PCLinuxOS.
I discovered that in using Amarok, my iPhone gets
mounted. And with a little bit of investigation, I am
able to browse the partial directory structure of the
iOS. I was able to create a symlink to the mount
point in an accessible location. Thereafter, I could
use GTKPod to add/remove music and picture files.
Amarok would have been an acceptable solution,
except that sometimes the album covers were not
saved on the iPhone.
If you already have Amarok installed, that's good.
Many of the dependencies needed should already
be installed. But if you haven't installed GTKPod, it
would be best that you do so, along with all its
dependencies.

Plug in your iPhone and you should get a notification
that a USB Imaging Interface has been attached
and is ready for some action.

At this point, it is only when Amarok is up and
running that are we be able to distinguish the iPhone
as more than just a digital device, and we are able to
add or remove music files to and from the iPhone.
Did I mention I had problems getting the album
covers?

How about GTKPod? Well it was a hit and miss thing
with the actual mount location. It was pretty much
the same with Dolphin. Sometimes it's there,
sometimes it's not.
I wasn't completely happy with the Amarok solution. I
needed to be able to mount my iPhone, even
partially, so I could also copy some PDF ebooks to
my iPhone folders. I was having very little success
with GTKPod until a knowledgeable PCLinuxOS
community member, AS, posted a forum reply, and
together we worked on a solution that can trick the
Device Notifier into recognizing the iPhone as a
storage device.

Mounting the iPhone on PCLinuxOSMounting the iPhone on PCLinuxOS

http://www.pclinuxos.com/forum/index.php?action=profile;u=31251
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Let's start all over again
Quit Amarok and any other application using the
iPhone and unplug it!
The following procedure is how we were able to
accomplish the task and make PCLinuxOS a much
friendlier distro to iPhone users. The steps outlined
here should also work on other desktop
environments, although the tools used might be
different.
First, let's create a folder where we can mount the
iPhone, and either /mnt or /media should be an ideal
place. For the sake of consistency in this procedure,
we will use /mnt.
On the Konsole, type su  followed by your root
password then Enter.
Type mkdir /mnt/iPhone [Enter]
The folder belongs to root and has the right
permissions. You'll need to change the ownership of
the folder to your user so you can have read and
write access to it.
Type chown <user>:<user> /mnt/iPhone
where <user> is your user account.
If the permission is not quite the same with drwxrxr
x, you can type in the command, chmod 755/mnt/iPhone [Enter].
Note that the iPhone folder on /mnt/ will be there
permanently, and will not be removed upon
umounting of the device.

Let's exit Konsole for now, and add an iPhone entry
on Dolphin. Open Dolphin and make sure that you
have Places enabled on the sidebar. If you don't
have it, just press F9.
On any empty area on Places, rightclick and select
Add Entry. On the Add Places Entry dialog box,
type in the following:
Label: iPhone
Location: /mnt/iPhone
Click on the folder icon on Choose an icon and
locate a cool iPhone icon. If you dont have any,
there are some good stuff over at Interfacelift or you
can try this iPhone icon. Click OK and you should
have an additional entry for iPhone on your Dolphin
sidebar. When you click the icon now, there won't be
anything in Dolphin to display.

The Script
To get all this in place, we will need to be able to
mount (and necessarily, unmount) the iPhone. For
this, we will need a script to trick Device Notifier into
recognizing the mount point as a storage device.
Open Kwrite and type in the following simple script.
#!/bin/shmntp=/mnt/iPhoneif ! ( mount | grep $mntp ); thenifuse $mntpnotifysend u normal "iPhoneMounted" "The iPhone is now mounted."dolphin $mntpelsefusermount u $mntpnotifysend u normal "iPhoneUnmounted" "The iPhone is nowunmounted."fi

Mounting the iPhone on PCLinuxOS

http://interfacelift.com/icons/downloads/date/linux/
http://www.iphone4jailbreak.org/forum/wp-content/uploads/iphone-4_apple_icon.jpg
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Save the script (as any appropriate filename; AS
suggested mgmt.iphone.sh) to any safe location
and make sure it is executable  chmod o+xmgmt.iphone.sh
To break the script down, ifuse $mntp is the
command to mount the iPhone. What the script
would do when it is executed is to mount the device
and open the mount point in Dolphin. Or, if already
mounted, it would unmount it with fusermount u$mntp.
But the script is too cumbersome by itself. So, what
we need to make the PCLinuxOS user's life easier is
to add another action to the USB Imaging Interface
when the device is detected by Device Notifier.
When clicking the action, the script would be
executed and the iPhone would be mounted,
followed by Dolphin opening the mount point’s
directory. Another click on the action would unmount
the device.

The Device Notifier
Open KDE System Settings (aka Configure Your
Desktop). Navigate to Hardware > Device Actions
and click Add. Type in Mount or Unmount iPhone
in the Action name dialog box and click OK.

In Editing Action Mount or Unmount iPhone
dialog box, click the floppy disk on the right hand
side of Command and locate the script. Change the
icon accordingly.
Change the Parameter type to Property Match, the
Device type to Camera, the Value name to
Supported Drivers, and in Equals, type gphoto.
Click Save Parameter Changes then OK. Close
KDE System Settings.

Let's see how we did so far. Plug in your iPhone
and Device Notifier should popup with 4 actions.
Click the USB Imaging Interface to expand the
actions, and you should be able to see the additional
actions, Mount or Unmount iPhone.

LinPC.us

Advertisement

Mounting the iPhone on PCLinuxOS

http://www.linpc.us
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Click the action, Mount or Unmount iPhone.

Eureka! A partial mount of your iPhone's iOS tree
structure! Actually, it is only the contents of
/var/mobile/Media/ on your iPhone. I am guessing
that this would be the equivalent to /home/<user>
on PCLinuxOS, but that should be enough to get us
going.

GTKPod
This fantabulous application is a graphical user
interface for Apple's iPods and iPhones for Unixlike
systems, written in GTK+. It provides an iPhone
ownercumLinux user a means to organize his
device — add/remove music files, sort out photos,
etc.

The first thing you need to do is set up connecting
your iPhone. On the menu, click Edit then
Repository/iPod Options. Click Add new
repository/iPod...
In Create Repository dialog box, the Repository
type should be iPod and type in a name for the
Repository name. The iPod mountpoint should be
/mnt/iPhone. You can leave the iTunesDB backup
as is, as the backup file will be created as you
organize your iPhone. Select the correct Model from
the dropdown box.
For the time being, we will leave the
Synchronization section blank. but there are
several scripts in /usr/share/gtkpod/scripts. At the
time of writing this article, I haven't had the chance
to test them out.
Select the iPhone, or whatever label you used for it,
from the list and click Load iPod. At this point, it

might take a while (depending on how many music
and picture files you have on your iPhone) to "hash"
the contents of your iPhone. Once it is done, you will
have the additional sections on your iPhone ... and
you are in business!

Mounting the iPhone on PCLinuxOS
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by Meemaw
If you do a document on a regular basis, it might be
a good idea to save it as a Template or a Master
Page. With my newsletter at work, I use the same
basic layout every time, with the title page being of
one design and the remaining pages being different.
I have saved the basic layout as a template, which I
can open from the start screen (remember one of
the tabs said 'New From Template'). If I want to
change anything in the basic layout, I can do it
because it's a template.
On the other hand, here at the magazine, we use a
Master Page so every page of the magazine has
exactly the same border at the top and bottom. You
can always cover those borders with
something else, but the master page is
locked so it can't be altered easily.
Both the template and the master page
are handy items to have, each very
useful in its own way.

Templates
Making a template is the same as doing
a onepage or severalpage project.
The difference is, in your newsletter or
magazine, you will fill the text frames
with your stories. In your template, you
will place the text and graphics frames
you plan to use most of the time, but
won't enter any text into the story editor
or any images into the image frames.
The first page of my newsletter looks
very much like the image here. >

My first page generally has the main story in the
frame on the right, one small story or
announcement in the rounded frame at the
bottom left, and the table of contents of the
newsletter in the open space at top left. My
second, third and fourth pages have a different,
smaller header than the first page, but are more
identical to each other, and have the page
numbers already on them. I generally use the
same page format as page 1, with a narrow
column on the left and a bigger column on the
right, and one of the stories on each page having
the rounded frame around it. Since the reader’s
eye will be drawn to a darker or thicker frame, I try
to place more important notices or stories in that
frame.

Since I use this format
most of the time, I have
made it into a template.
To save it as a template,
just choose File > Save
As Template... You will
be asked to name your
template. If you use
something frequently,
you should save it.
To use your template,
simply open it, and then
resave it with the title of
your present project. My
newsletters are
generally saved as
“Company_Newsletter_
June2011” or something
similar. After you have it
saved, create!

I found a couple of sites that have templates you can
download for yourself:
http://scribusstuff.org/
http://www.oaktree.us/2010/08/21/modern
templates/
http://www.scribustemplates.org/ (seems to be a site
in a state of change)

Master Pages
On the other hand, maybe you have a specific page
design you want to apply to some or all of the pages
of your newsletter. Maybe you aren’t sure how many
pages your newsletter will be, or what will be on
each page. My newsletter is four pages every time,
and the pages, while being the same general

Using Scribus, Part 6: Templates & Master PagesUsing Scribus, Part 6: Templates & Master Pages

http://scribusstuff.org/
http://www.oak-tree.us/2010/08/21/modern-templates/
http://www.scribustemplates.org/
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design, are not identical, and can be changed any
time I choose to change them.
The magazine, however, has the same design for
every page, so when several people work on it, the
finished product has a unified look. The magazine
uses a Master Page. It is a onepage design that
has the header and footer and the columns already
established. (Looks pretty empty, doesn’t it?)

To do a Master Page, you open a new document,
format it the way you want it (margins, orientation &
so on), then choose Edit > Master Page. You will
get a small window which has several buttons (New,
Copy, Import and Delete) plus one entry, Normal.
Since you are creating a new page, click on the first
button on the left (it should say ‘New’ when you
hover your mouse over it.) Another small window will
pop up, asking you to name your brand new master
page. I named mine MeemawsOwn, but you should
name yours something more appropriate for you.

Click OK. Now you will see the name of your new
master page in the list. (below)

Make sure it’s highlighted, because that’s the one
you want to edit. Leave this small window open!
That is how the program knows you are editing that
master page.

Now, put in the header and footer information you
want to have on that page. If you use 2 columns all
the time, put frames in for them. If the text should
flow from left to right through the columns, you can
put that in as well. If you always have a logo in a
certain spot, put that in and lock it down.
When you are finished editing your page, you can
click on the save button in the main toolbar, and give
your document a name. Only when you have saved
your page should you close the Edit Master Pages
window. If in the future you want to alter your page,
you simply go to Edit > Master Pages again, edit
the page the way you want, resave, and close
again. (below)
If you have opened a
document and decide
that you want to use your
master page, you can go
to Page > Apply Master
Page and a window will
open asking which pages
you want to apply it to.
Choose yours. If you
have a multipage
document, you have the option of applying the
master page to certain pages, or all of them. It will
be applied to the page or pages you have
designated.
Templates and Master Pages are very useful, each
in their own way. If you want to save some time in
your creation, experiment with each and develop
what works for you.
Next time, we will look at ways to give your
document a little flair.

Using Scribus, Part 6: Templates & Master Pages
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Answers on Page 24.

Double Take & Mark's Quick Gimp TipDouble Take & Mark's Quick Gimp Tip

The Gimp is exactly like other
photo editing programs. It uses
the standard approach of multiple layers to
create a composite image. (The default file
format for Gimp layered images is .xcf.)
But what about those times when you may
not want to add a new layer behind an
existing layer? Perhaps you just want to
add a couple of pen strokes that fall behind
the subject. The common way to
accomplish this is to simply create a new

Mark's Quick Gimp Tip
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layer, make it transparent, and drop it
behind the primary layer. Or, you can, use
the brush option “Behind” (especially if it's
an edit that's not too involved). With the
brush/pen in draw mode “Behind,” you
draw on the transparent area of the layer
but the brush stokes fall behind the object
on that layer. In the example at right, I've
isolated the figure (that's me!). I've simply
selected the Spark brush and selected the
“Behind” brush/pen mode. Wherever I
draw on that layer, it falls behind the figure.

It all
happens on
one layer.
No need to
create a new
layer and
place it
behind the
primary
layer.
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Mark Szorady is a nationally syndicated cartoonist with georgetoon.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.

http://www.georgetoon.com
mailto:georgetoon@gmail.com
http://www.gimp.org/
http://www.georgetoon.com/blog
http://www.gimp.org/
http://www.georgetoon.com/blog
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by Paul Arnote (parnote)

If you can, try to imagine yourself making the switch
from Windows to Linux … today. Is there any
surprise at the confusion experienced by those
Windows users braving the switch to Linux? Let’s
take a look at some of the issues these new Linux
users face.

Which Linux distribution?
So which Linux distribution should a new user start
with? Just take a look at the list on the front page of
Distrowatch.com — this is a list of the top 100 Linux
distros! Can you imagine trying to choose which
“version” of Linux to trial, from a list of 100? In the
“Windows World,” users have only four or five
versions of Windows to choose from.

The list of 100 top Linux distros is only the tip of the
iceberg. According to OperatingSystem.org, there
are 605 different Linux distros. Distrowatch (as of
May 1, 2011) lists even more (681), and breaks the
list down to active (319), dormant (56), discontinued
distros (306), as well as listing 247 as being “on the
waiting list.” Granted, some of those in the list are no
longer around. Yet when a new user is faced with
the choice of over onehalf of that number, say 300+
different Linux distributions to choose from, armed
with nothing more than a desire to leave the
Microsoft and Apple merrygoround, it’s a miracle
that even some of them discover Linux to be a
workable alternative.
Choose wrongly, and the new user will get a bad
feeling for Linux. They will run off, into the night like
Paul Revere on his midnight ride, decreeing that
Linux is not yet ready for “prime time” and that “Linux
sucks” to anyone who will listen. Choose correctly,
and that same new user will wonder why they didn’t
switch sooner, and how they ever survived without
Linux. That initial experience with Linux will be highly
dependent on how well their hardware is detected,
and the stability of the Linux distro that they chose.
Choose something like Fedora, which is considered
to be more “cutting edge” than most other distros,
and you may end up with stability issues. Choose
something like Debian or PCLinuxOS, which have
reputations of having only the most stable
applications in their repos, and you are likely to have
a very stable system.
Some computer users switching to Linux rely —
rightly or wrongly — on the advice of a wellmeaning
friend. This can end up being a doubleedged sword,
depending on the level of experience the “friend”

The Linux Landscape: A Sea of Confusion?The Linux Landscape: A Sea of Confusion?

http://www.distrowatch.com
http://www.operating-system.org/betriebssystem/_english/os-liste.htm
http://distrowatch.com/weekly.php?issue=20110425#waiting
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has, coupled with their proficiency with Linux. Taking
the advice of a friend who has neither could spell a
recipe for disaster, while taking the advice of
someone with a fairly good level of experience and
proficiency can help the new user make a smooth
transition. The latter is only possible if the friend is
capable of breaking things down into an easyto
understand manner, and as long as the friend
doesn’t forget that they also had to learn Linux from
the ground floor. With some people, that higher level
of proficiency and experience can be something that
turns new users away from Linux, if the assistance
isn’t conveyed in a constructive and encouraging
manner.

One thing that certainly does not help is the users of
one Linux distro bashing and badmouthing the
users of another. Nor does it help to have
overzealous fans singing the praises of one Linux
distro over another with claims that are not easily
substantiated or claims that are more a product of
hype and other unrealistic claims. Typically, the old
adage “if it’s too good to be true, it probably is,”
tends to ring true. The distro bashing and fan boy
claims turn potential new users off, and often make it
appear that even Linux users cannot even get along
with one another. It often appears as if there is a civil
war brewing among Linux users.
With the free, open source nature of Linux, distro
bashing is much like shooting yourself in the foot —

and in the end, it may end up shooting us
somewhere much more vital. Since Linux is FOSS
(free, open source software), many distros “borrow”
from one another all of the time. Even in
PCLinuxOS, it’s not uncommon to see a mix of ideas
borrowed from other distros, without prejudice. If it
works, why not use it? This is also one of the
reasons that distrobashing in the PCLinuxOS forum
is not allowed.
Imagine this, if you can. You need a new tail light for
your 1991 Chevy Corsica. You go down to the
salvage yard. They tell you they don’t have any 1991
Chevy Corsicas that you can get the part off of, but
they have a 1992 Buick Skylark, which used the
same tail light. (By the way, I don’t really know if the
two tail lights are the same. I’m simply using this
situation as a metaphor to illustrate my point.) Would
you pass on the tail light, just because it came from
a Buick Skylark, and not a Chevy Corsica, despite
the fact that it’s the very same tail light, both made
by General Motors? We all are running Linux, and all
Linux distros borrow ideas and code from one
another. So, by bashing another Linux distro, we are
doing nothing more than bashing ourselves.

Desktop Choices
As if it isn’t bad enough to wade through 300+ Linux
distributions, now the user will have to choose which
desktop environment to use. For users coming from
an environment where there primarily is one desktop
environment available, they all of a sudden get hit
with probably no fewer then 100 different choices
about how to interact with their computer desktop.
Even with PCLinuxOS, users have no fewer than six
choices: KDE, Gnome, Xfce, LXDE, e17 and

The Linux Landscape: A Sea of Confusion?
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Openbox, with possibly even more choices in the
future.
Add into this the distinction between a desktop
environment and a window manager, and how those
lines sometime become quite blurred, it’s perfectly
understandable that new Linux users will have some
confusion about what they should use.
To be fair, many of the desktop environments and
window managers are mostly niche players, and
haven’t gained widespread acceptance.
Nonetheless, they still exist. It would probably be
best to restrict new users to the most popular
desktop environments, such as Gnome, KDE, Xfce,
LXDE and e17. Of those five, KDE is the desktop

environment that is most like Windows, which may
make it one of the easiest ones for Windows
refugees to adapt to and adopt.
Why, you may ask? Since there are more Linux
users using those desktop environments, it will be
easier for the new user to find help when they get
into a bind. Also, many of those desktop
environments operate a lot like the singular desktop
environment they arrived from, so the new user can
concentrate on learning the differences of Linux,
compared to that “other” commercially available
operating system. Given the chance to adapt to the
Linux file system and other differences in Linux will
help ease the new user into total adoption of Linux
as their primary—or even sole—operating system.

Attitudes & Perceptions
Once a new user has chosen a distro and desktop
environment, the next hurdles to jump are the
attitudes of some Linux users, as well as the
perception of Linux. Don’t underestimate the impact
of these two items — they can make a formidable
barrier for the new Linux user.
Let’s start with perceptions, first. Linux is seen as
being closely related to Unix, which has been used
in scientific circles for … well, forever. As a result,
Linux is seen as the playground for “geeks.” Linux
also has a common, albeit wrong and undeserved,
perception of being for hackers.
While it is true that Linux is used in many scientific
circles, this fact should stand as a testimonial to
Linux’s flexibility, as well as its abilities. Linux gained
these inroads into scientific circles precisely for

these reasons, coupled with its security, both for
user data and its core components.
Today, using Linux on a home computer is no more
difficult than using any of the commercially available
operating systems. All operating systems have a
learning curve, whether it’s Windows, OSx, Linux, or
anything else. No one was born knowing how to run
any of them. Despite that, Linux has the reputation
of being the “secret weapon” of hackers, and one
where you are always having to tweak and mess
with your computer. However, nothing could be
further from the truth. Personally, I do less tweaking
and messing with my computer running Linux than I
ever did running Windows. Things just work. Period.
As far as being a hacker’s playground, there are just
as many “hacking” tools available for the
commercially available operating systems as there
are for Linux.

The Linux Landscape: A Sea of Confusion?
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Attitudes are another thing, and one that won’t go
away any time soon. Although not the way practiced
in the PCLinuxOS Forum, there are still many other
Linux forums where questions from new users are
greeted with “RTFM” (Read The Freaking Manual,
except another word is most often substituted for
“freaking”) — or one of about a dozen versions or
derivatives on that same theme. Among some who
are more experienced with Linux, it’s as if they view
it as a “rite of passage.” Because they, (the
experienced users), had to figure stuff out on their
own, mostly by reading the manual and other
documentation for a program, they think EVERY
Linux user should have to do the same.

Such attitudes give Linux the reputation of being for
elitists, and it’s a reputation that Linux needs to
shed. As Linux grows in popularity — and its
popularity is on the rise — there is no need for these
attitudes towards new users. There is now enough of
a Linux user base that help should not be far away.
While I applaud those who had to endure the lack of
support and the “figure it out on your own” early
days of Linux, and survived, making it easier for new
users to adopt Linux and avoid the rituals of the

early days of Linux should be the norm, and not the
exception.
After all, these days, there is a larger Linux user
base — one that is growing larger every day — than
in days gone by, and it’s no longer necessary to
force new users to “pay their dues” just to be able to
run Linux. Being friendly to and offering to help new
users is a great step towards retaining those users.
They sought out Linux not because they had to, but
because they wanted to.

Free vs Paid
In many Western cultures, there is a commonly held
belief that things of value have a higher price
attached to them. There is a large group of computer
users who feel that if Linux had any real value, then
someone would be charging for it. They simply don’t
understand the very different business model that
Linux operates under. How can development
continue, especially at the current pace, when you
give away the end product?

What isn’t visible to many is that much of the
development is funded by many heavyhitters and
big players in the computing industry. This includes
companies like IBM, HewlettPackard, Cisco, Red
Hat, Google, the Mozilla Foundation, and many
others. Let’s take Red Hat as an example. Red Hat
markets Red Hat Enterprise Linux, which is a
version of Linux with paid enterprise support. It’s not
the actual operating system that is being sold.
Rather, it’s the paid support that is sold. Red Hat
makes its money from selling that support. IBM
makes money selling an enterprise version of Linux,
as well as the equipment to run it on.
Many companies profit from contributions to the
Linux code base by not having to pay licensing fees
for the use of commercial operating systems. In fact,
Linux shows up in some of the most unlikely places.
It serves as the operating systems that run DVD
players, menus on TVs, cell phones, and many other
consumer electronics goods. From working in a
hospital, I can tell you from first hand experience
that it also shows up in medical testing equipment.
Linux is everywhere today.
As it turns out, the financial contributions to
improving Linux come at a far less expensive price
than licensing commercial operating systems.
Employing teams of Linux programmers to make
those improvements, to tweak Linux to do what they
need Linux to do on these various devices, benefits
not only themselves, but the entire Linux FOSS
community as a whole.
Community developers, usually those who do it for
pride and to learn, then take those contributions and
further enhance them, which in turn, further benefits
those companies who are funding development.

The Linux Landscape: A Sea of Confusion?
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Fedora Linux is (more or less) the free version of
Red Hat. Things are developed and tried with
Fedora, and those items that work, along with the
information learned, then make their way to Red Hat
Enterprise Linux.

So, as you can see, there is a symbiotic relationship
between those who fund and contribute to Linux
development and the Linux FOSS community. Both
benefit from the continued development of Linux.
You may be wondering then, how community based
distros, like PCLinuxOS, survive and get by. Quite
simply, they survive from donations from the
community of users that use it. The money that is
donated goes to pay the living expenses of the main,
lead developer (Texstar, in the case of PCLinuxOS),
as well as the server expenses to host the ISO’s of
the distro and the programs in the repository. Instead
of paying $300 to $400 every couple of years for a
copy of a commercial operating system, users pay
$25 (or more — your conscience is your guide) to
the developer to help keep development going. No

one is getting rich from development of community
based distros. Just ask Texstar. He’ll give you an
honest answer.
As a matter of public record, there are Linux distros
that are largely funded by the financial wealth of
individuals, much as Ubuntu receives a significant
amount of its funding from Mark Shuttleworth, who
started Canonical. This situation, however, is the
exception, and not the rule. PCLinuxOS does not
have any wealthy individuals underwriting and
backing its continued development. Instead, it
survives purely on the generosity of its users and the
donations they make.
Other cost savings to users of Linux come from the
use of not only a FOSS operating system, but by
also the use of FOSS programs in its repository.
Sure, Linux doesn’t have the use of Microsoft Office.
Instead, we have the use of LibreOffice. Instead of
paying another $200 or more for the use of an office
suite, we use LibreOffice for free. All across the
board, virtually every program used on Linux is free
software, whose development is largely funded in
the same way as Linux itself. Linux users save even
more by not having to purchase not only the
software that is used on a daytoday basis, but also
by not having to purchase antivirus, antispyware
and antimalware software. To date, there are no
Linux viruses in the wild. So (at this time) it is
pointless to run antivirus software on Linux —
unless you are trying to help protect Windows users
who may receive files from you.

Summary
Don’t get me wrong. There is a lot of good about
Linux. I love Linux. I wanted to try to take a look at
Linux from the view that a new user, fleeing the
tyranny of the closed source operating systems
produced by Microsoft and Apple. Once we, as the
Linux community, stand in their shoes and try to
understand how they see things, the more we’ll see
Linux grow.
I also wanted to take a look at Linux from the
viewpoint of its detractors, and in the process, try to
dispel some of the misconceptions and
misinformation. By doing so, it gives all of us a better
understanding.
Is Linux for every computer user? Probably not.
Some folks needs are perfectly served by Windows.
Some folks computing needs are perfectly served by
OSx. Should every user switch to Linux? Probably
not. At the very least, users should at least know that
another option does exist. As it stands now, many do
not even know that Linux exists.
The answers for getting the word out about Linux
are not clear. With no traditional funding, there is no
way to pay for advertising. For now, word about
Linux is spread by “word of mouth,” and that looks
unlikely to change anytime soon.
So, is there anything we, as Linux users, can do?
Absolutely. First, we can stop bashing one another.
Despite calls for Linux distros to band together to
create fewer, larger distros, I do not believe that is
necessary. In fact, I take a more Darwinian
approach, where those distros that are most fit and
that best support the needs of their users will be the
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ones that survive. Those that do not best support the
needs of their users and that are not fit, for whatever
reason, will not be able to continue. There will
always be niche distros to cater to the specialty
needs of small groups of Linux users. However,
continuing to bash one another for using one distro
over another has to stop. We are all, after all, using
Linux. We have that kinship with one another.
Secondly, you can help spread the word about
Linux. In doing so, be careful to avoid outrageous
claims. Just stick with simple facts. If given a
chance, Linux will sell itself. The work of the
developers will sell Linux.
Third, help new users. Avoid the use of “RTFM.” The
days of “paying your dues” is behind us, as well it
should be. Linux users have now grown to such
numbers that there should be plenty of help to go
around to those users who willingly and voluntarily
come seeking Linux.
Fourth, show potential new users your Linux
desktop. Show them how many of their learned
computer skills will transfer to Linux. Show them how
their daily computing needs can be met with an
operating system that doesn’t cost them a week’s
wages.
While we won’t be able to afford big advertising
budgets or be able to pump huge amounts of cash
into a distro, there are lots of things each of us can
do to help Linux gain the respect and loyalty of those
new users. They are, after all, the future of Linux.
Most of us sought refuge with Linux. In fact, very few
of us actually started our computer usage with Linux
as our primary operating system. Most of us actually

started with Windows. As such, it makes little sense
to make new Linux users “pay their dues.” By
helping to make the transition as smooth as
possible, by offering the assistance that new users
will undoubtedly need, we can retain a larger

percentage of those new users. If Linux is to grow
and prosper, as it can and should, we need to
encourage those new users to stick around,
especially since they came willingly to seek a viable
alternative to the commercial operating systems.

Screenshot ShowcaseScreenshot Showcase
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Linux Belongs To EveryoneLinux Belongs To Everyone

MP3 OGG

Linux belongs to everyone
The best things in life are free
Download PCLOS and enjoy it just like me
Texstar's design is so refined
He can compile with oh such style
And Linux can come to everyone
The best things in life are free

PCLOS fits everyone
Many choices for you and me
It's the OS for everyone on that we all agree
Your desktop will shine just like mine
Get it now it is the time
And Linux can come to everyone
The best things in life are free

http://www.pclosmag.com/html/Issues/201106/files/linuxbelongstoeveryone.mp3
http://www.pclosmag.com/html/Issues/201106/files/linuxbelongstoeveryone.ogg
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by Paul Arnote (parnote)

Can I copy my DVDs?
Before I get into talking about the DVD2Xvid
program, it’s only fitting that we discuss this hot
topic, one that has spawned many heated debates
and arguments. The law is quite ambiguous. In the
U.S., there appears to be significant conflict between
the “old” copyright law and the DMCA (Digital
Millennium Copyright Act) amendment to that
copyright law regarding fair use by consumers and
circumventing access controls. According to the
writers of the amendment, the DMCA does not trump
traditional use of copyrighted materials, as has been
previously established by law and the courts.
Although the Hollywood movie studios and the
MPAA would love for you to believe otherwise, it IS
perfectly legal (in the U.S., anyways; check the laws
for your region of the world) for you to make a
backup or archival copy of your legally purchased
DVD movies for archival purposes. But that’s only if
you are a U.S. citizen, and if you go by the U.S.
courts rulings regarding copyrights and your rights to
make a personal, private archival copy. That archival
purpose could include creating a copy on your home
media server’s hard drive, eliminating the discswap
dance involved with watching the movie as it is
presented on the DVD drive.
The DVD disc producers even go to great lengths to
prevent you from making that legal archival copy,
with copy protection schemes that have become
quite elaborate and tricky. Presumably, the movie
studios claim that the copy protection schemes are
needed to prevent piracy, which can be quite

troublesome to the bottom line when it comes to
home video sales of a title. For many movies, the
revenue from home video sales can provide huge
relief for a movie that had lackluster performance at
the box office. It’s also the reason why so many
recent box office releases find their way to home
video within a few months of the film’s original
release.
I doubt that there will ever be any way to eliminate
piracy, and it seems that more money is spent on
trying to eradicate piracy than the piracy itself costs
the movie studios overall. While those committing
piracy should be prosecuted, going after and
prosecuting/persecuting the average home
consumer who makes an archival copy of
copyrighted media for their own personal use is NOT
the answer. Nor is going after the authors of
software to circumvent access controls the answer,
since it tends to do more to stifle innovation and
competition.
Whatever the case, we won’t settle the issue here, in
the pages of The PCLinuxOS Magazine. At least you
have some idea of the ground this debate covers.

DVD2Xvid
The whole idea behind DVD2Xvid is actually pretty
simple: take a DVD, and rip that DVD to an *.avi file,
encoded with the Xvid video codec. The choice of
Xvid is an outstanding one, since the Xvid codec
offers really good compression and very good
quality, as well as the ability to vary the quality from
passable to excellent. Many Xvid encoded files will
also play back on set top Divxcapable players, so
you can rip your archived DVD movie, burn it to a

blank CD, and play your copy. This will allow you to
leave the original in a safe place, so it doesn’t get
damaged. DVD2Xvid is available in the PCLinuxOS
repository.

When you first start up DVD2Xvid, you will see the
screen above. For my “test run,” I chose the
animated feature “The Brave Little Toaster” as the
DVD title that I was going to rip.

Video: Part 7 - DVD2XvidVideo: Part 7 - DVD2Xvid
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If DVD2Xvid does not immediately find your DVD
title, click on the “File” button at the very top of the
window and point DVD2Xvid to the directory that
contains your DVD’s VIDEO_TS directory. You will
also need to select the output file name and
directory. Here, I chose to name my file
the.little.toaster.avi, and to store it in my
/home/parnotexfce/Recordings directory. Clicking
the button next to “Select Outfile” will open a “File
Save As...” dialog box.

Next, select the title on the DVD that you want to
make into an Xvid endoded AVI file. All of the titles
on the DVD will appear in the drop down listbox.
Typically, the longest title on the disc is the feature
film. To be sure you have selected the correct title,
select the “Preview” button on the right to play the
selection in a pop up MPlayer window.

Under “Picture quality settings,” select the options
you want to use when transcoding your DVD title to
an Xvid AVI file. Select the video bitrate you want to
use. The default value is 1000 kbps. Here, I selected
1200 kbps, from the drop down listbox. Select the
level of “Motion search algorithm” you want to use.
While “0” is the default value, selecting a higher
value will make motion search between frames
much more sensitive, although higher values will
slow the transcoding process. I have found the
default setting to work just fine, for my needs.

I have also selected “2Pass encoding,” which will
give me a much higher quality image, despite taking
twice as long to encode, since the movie is scanned
twice—once to study the video and learn how to
optimize the video, and a second time to record the
video using the optimizations learned on the first
pass. I’ve also selected the “Autoaspectoption,” so
that the aspect ratio of my video matches the
movie’s aspect ratio as it is on the DVD. Finally, I’ve
also selected the “Cartoonoption,” since the title I am
converting is an animated feature.

In the next section, “Audio encodingoption,” you can
select the options for the audio portion of your
transcoded video file. You can select two
soundtracks for your video file. For the first one, I
simply selected “Standard sound.” I opted to have
no second soundtrack, hence the “without” as my
selection in the second soundtrack list.
For “Encodingoptions,” I’ve simply selected to “copy”
the sound from the DVD to my AVI file, and it is the
default setting in DVD2Xvid. You can also choose
AC3 or faac as the audio codec. If you select one of
the alternate audio codecs, you can also select the
audio bitrate to use to reencode your audio. Since I
have elected to copy the audio, I cannot change the
audio bitrate.
Finally, you can select subtitles to include in your AVI
file. I have chosen to not use subtitles. “Without
subtitle” is the default value. However, should you

want to include them, you can select the subtitles
from the DVD in the drop down listbox.

Under the “Time settings” section, you can select to
advance or delay the audiovideo sync, if you are
having problems with the audio syncing properly
with your video images. Enter either a positive or
negative number into the “Modify timeline” box, and
the audio will be either advanced of delayed by that
number of milliseconds.
You can also record portions of a DVD title. Enter
the start time where you want to start recording in
the “Start by” fields, followed by the end time in the
“Stop by” fields. The three entry fields represent
hours, minutes and seconds.

Once you have all of your settings as you want
them, click on one of the buttons at the bottom of the
window. The buttons at the far left and far right of the
screen should be quite obvious. Selecting the
“Append” button will add more “jobs” to the batch
processng list.

Video: Part 8  DVD2Xvid



21

After you select the “Start” button, the main
DVD2Xvid window will disappear, and the above
window will take its place. This window will show you
the progress of the transcoding process. Since most
of the information in the window has German labels,
you will probably be most interested in the “Groesse”
(Size), “Restzeit” (Remaining) and “Encodiert”
(Encoded) information. The Remaining label will
display an approximation of how much time is
remaining for the current phase of the encoding
process to complete. The Size label will display an
approximation of the final file size, which really isn’t
accurate until you get into the second pass of a two
pass encoding. The Encoded label will tell you how
many sectors have been encoded, along with the
percentage of the current phase of encoding is
completed.

Summary
DVD2Xvid is a handy tool to have, especially if you
have a home media center. For example, my
transcoding of “The Brave Little Toaster” from a DVD
to an Xvid encoded AVI file, stored on my hard drive,
ended up weighing in right at 900 MB in size. This
saves a LOT of space, when you consider that
copying a DVD to your hard drive will often take up
anywhere from five to ten GiB of space.
Certainly, I could have made the transcoded video’s
file size even smaller, by selecting a lower video
bitrate, along with reencoding the audio to another
codec at a lower bitrate. I have (and have seen)
other videos encoded at video bitrates as low as 500
kbps, and even they were quite watchable —

although the quality loss does start to become quite
noticeable once you select video bitrates under 800
kbps.

The use of DVD2Xvid is easy and straight forward,
and makes the job of creating digital backup copies
quite simple.

Screenshot ShowcaseScreenshot Showcase

Video: Part 8  DVD2Xvid

Posted by raregazz, May 10, 2011, running Openbox.
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by Darrel Johnston (djohnston)

In 1999, my parents became the proud owners of a
Dell Dimension 4100 computer. The specifications
were pretty good at the time. It came with a Pentium
III 800 MHz processor, 128 MB of PC133 SDRAM,
an ATA100 Ultra DMA 10 GB hard drive, an 8X
CDROM, an ATI AGP (4X) video card with 16 MB of
video RAM and a 200 watt power supply. It also
came with two PS/2 connectors, two USB 1.0
connectors, five PCI 33 MHz slots, two 5.25inch
drive bays and three 3.5inch drive bays, an internal
56K modem, a generic sound card and a floppy
drive. (Remember those?) I don't know why there
are five drive bays, because there are only two IDE
controllers on the mother board, each with two
channels. I suppose the extra bay was originally
designed for a Zip drive connected to the floppy
drive controller. Surprisingly, although it was
available as an option, the computer came with no
ethernet controller.

My dad was "in charge" of the computer. He would
not allow my mother to use it without his supervision
(but that's another story.) He signed up with various
voicegrade Internet providers over the years,
eventually becoming dissatisfied with each one in
turn. He mostly used email and only occasionally
browsed the world wide web. It was when he
browsed the web that the complaints about slow
access speed came into play. The computer came
equipped with a factoryinstalled copy of Windows
98 First Edition. He was so proud of the fact that
Microsoft shipped him a Second Edition upgrade CD
in the mail, after he requested it. "They didn't even
charge me," he would boast. (Little did he know.)

Three times that I'm aware of, he contracted
Windows viruses that either rendered his computer
unbootable, or compromised some functionality. He
would call the Dell help desk to help him "diagnose"
the problem. I became involved twice in his Windows
98 escapades when he could no longer boot the
machine due to another malware infection. "Why
would anyone do such a thing?" he would ask
angrily. "Don't people have any respect for private
property any more?"

It was then that I took the opportunity to explain the
benefits of using Linux. "Can I use the Internet with
it?" I explained that I would have to run tests to see
what would work with his modem. "Will it run

Microsoft Works?" That was where we hit a snag. I
explained that although he could not run Works, I
could install equivalent software to replace it. The
funny thing was that he couldn't live without Works,
even though he had no saved documents created
with it. (Stockholm syndrome? Talk about a captive
audience!) Stranger still, both times I got his
computer up and running again, I did so by using
Fprot from a Linux live CD to quarantine the affected
files. Even after the demonstrations of Linux's
usefulness, he would have no part of it.

My dad, bless his soul, passed away a few years
ago. My mom eventually became frustrated with
Windows 98. "Why did it run out of system
resources?" I showed Mom that the unused portion
of Windows 98's 128 MB of RAM was still pretty
healthy. To this day, Windows 98 has a system bug
that no amount of RAM will ever cure. Eventually,
the user will run out of system resources, and will be
forced to reboot in order to do anything useful with
the computer. And, by this time, Windows XP had
come out. Mom first wondered how much it would
cost to install Windows XP. The retail price of the
installation CD was enough to give her sticker
shock. I also informed her that we'd have to add
some system memory to run it. "However," I assured
her, "I can install something to replace Windows.
You can do everything you do now, you'll never get a
virus, and you'll almost never have to reboot."
Because she was having to reboot every other day,
not having to do that was a plus. Then, when she
learned that this Windows replacement was
available free of charge, she was more than willing
to try it. I installed PCLinuxOS version 0.92 on her
computer, and she has used nothing but PCLinuxOS
since.

PCLinuxOS on Older HardwarePCLinuxOS on Older Hardware
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My mom is not what you'd call a power user. She
knows how to send and receive email, download
files, play music and videos and create documents,
mostly using Writer. I eventually taught her basic
editing keyboard shortcuts and how to keep her
system updated. As KDE progressed in features
from release to release, the computer's resources
began struggling to cope. After all, it was running in
128 MB of RAM and 16 MB of video RAM. I almost
always have spare computer parts, but I had no
SDRAM that would work in this Dell. I bought
a 256 MB stick to put in the empty slot on the
motherboard, giving the computer 384 MB of
RAM. About this time, Mom changed from dial
up Internet to highspeed cable. I put a spare
Intel gigabyte ethernet card in an unused PCI
slot. Now we're talking! The difference in
access speed to the Internet between dialup
and cable modem turned the computer into a
speed demon. However, as my mom's
computer skills progressed, along with KDE's
features, the wait times for some intensive
programs to load became a bit tedious. It was
at this time that I took Mom's computer and
gave her a modern AMD Athlon64 dual core
with 4 GB of system RAM. For her use, this
would be more than she would ever need.

I took possession of the Dell Dimension 4100.
In order for me not to lose patience with the
machine, I decided to upgrade it as much as
possible. The machine will hold a total of 512
MB of RAM, so I bought another 256 MB stick
to replace the 128 MB one. I originally
replaced the video card with a scavenged 512
MB nVidia AGP card. The GPU was cooled by
a fan which eventually burned out for some

reason. The computer now has a GeForce 6200 256
MB card in it, passively cooled. I had a SoundBlaster
Live PCI card in spare parts that went into it. The 10
GB hard drive was simply not going to be enough. I
installed two old hard drives, a 2 GB ATA66 IDE,
which now holds my swap and boot partitions, and a
40 GB UltraDMA ATA100 IDE. The factory stated 40
gigabytes is actually slightly less than 37 gigabytes
in real terms. The two USB 1.0 connectors just
weren't enough. I use a USB KVM switch, so both

connectors are in use by the mouse
and keyboard. So, I
also added a USB 2.0
PCI card with 5
connectors. Two 300
GB USB drives serve
as additional storage.
The last addition is the
replacement of the 8X
CDROM with a
Memorex 48X CDRW.
The computer still uses
the original 200 watt
power supply.

What do I use on this
puppy? Puppy Linux?
NO! Don't get me
started on always
running the computer
as root user. System
wide use of sudo is bad
enough. I run
PCLinuxOS 2010! Yes, it runs on this
system with 512 MB of RAM and 256
MB of video RAM. And, it runs
surprisingly well. I use both LXDE and

e17 desktops on it, with plenty of GTK+ and QT4
applications installed. In addition, I run
folding@home 24/7 on it. The swap partition is
barely even touched. This computer has now
become my "go to" backup desktop.

That sounds well and good, but will the computer
run the "bling" desktops? Here is e17 running
ecomorph. That’s not much of a stretch for this
hardware.

As it turns out, running compiz is not much of a
stretch for this hardware, either. CPU utilization and
system memory usage is very low. Here is compiz
running with my LXDE desktop. (next page)

PCLinuxOS on Older Hardware
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I would never recommend this computer for use by a
first time Linux user. It would simply not show the full
potential of Linux as compared to running it on a
modern computer. After all, this computer was
manufactured in either 1998 or 1999. The machine
is over ten years old! However, I would recommend
that anyone think twice about discarding a piece of
hardware like this. It still has its usefulness. It can
always be repurposed as a print server or router,
with the addition of an ethernet and a wireless card.

PCLinuxOS on Older Hardware
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Answers to Mark Szorady's Double Take:
(1) Glasses different; (2) Drawer missing; (3)
Television stand top thinner; (4) Handle grip longer;
(5) Television screen smaller; (6) Extra joint added to
lever device; (7) VCR to television cord different Posted by Ramchu, May 9, 2011, running KDE 4.
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by horusfalcon
In the May issue, we covered the basics of how to
plan and implement a backup strategy for the typical
PCLinuxOS desktop system. A part of that strategy
was to take an initial backup of the baseline system
configuration, a task for which Clonezilla Live is
admirably suited. What follows is a stepbystep
guide to making an image you can use to recover
from a crash.
Clonezilla Live is a Live CDbased Linux distribution
which has been customtailored for creating and
restoring system images. It is worth noting before we
get started that Clonezilla Live is never installed, it is
always run from the Live CD. It makes no changes
to an existing system when properly used, and is a
safe, fast, and effective backup tool.
What is a disk image? In really basic terms, a disk
image is a set of specially compressed files which
Clonezilla uses to take a sort of snapshot of an
entire disk or of a disk partition. That image may be
later used to restore that disk or partition to the
originally captured state. It may also be used on
systems with identical hardware to duplicate a
running system from a prototype machine onto all
the others. This process is commonly referred to as
cloning a system.
The baseline system configuration is best backed up
after all the postinstall configuration and user
customizations are done, but this is not the only time
Clonezilla Live can be useful  any time that a
complete image of a system is needed it would be
hard to find a tool that is faster, more reliable, or
easier to use.

Tool List:
The tools needed to do this task are:
A copy of Clonezilla Live burned to a CDR.
http://clonezilla.org/ covers the minimum system
requirements (which are quite modest for all except
the oldest hardware). I recommend burning to CDR
instead of CDRW simply because this won't
change, and because CDRW can be a bit slower to
burn and read.
A storage device capable of holding the image. I will
be using a portable USB hard drive for the purposes
of this article. A large flash drive could also easily
serve this purpose if the data set being imaged is
small enough (but it's likely to be somewhat slower).
Downloading CloneZilla Live:
Let's look at that first item: Clonezilla Live burned to
a CDR. To get an ISO image for Clonezilla Live,
browse to http://clonezilla.org/downloads/stable/iso
zipfiles.php and select an image that is right for
your hardware. The URL will take you directly to the
stable release images.
There are three basic variants of Clonezilla Live:
i486, i686, and amd64.
i486 is the most generic variant and works with
systems back as far as the Intel and AMD 80486
CPU. It should work in most every case except really
old hardware. If you own more recent hardware
(Pentiumclass and up) the optimizations in the other
two will prove to be better in terms of speed and
efficiency.

The i686 variant is for P6 microarchitecture Pentium
processors.
The amd64 variant, confusingly enough, is for both
Intel and AMD 64bit CPUs. I typically use the i686
for everything except the really old stuff, but find that
there is a small difference in speed on 64bit
hardware with the amd64 variant. I keep them all in
my toolkit.
As of this writing, the most recent stable version of
these variants is 1.2823. Go to the downloads site
given above for the stable releases and download
the ISO image needed to support your hardware.

Take note that a zip version of each release is also
available, but that we will use the ISO image when
making a Live CD. I will be using the amd64
variant, since the system I will be using for this
demonstration is an old Compaq V500 laptop (it has
an AMD64x2 CPU) with PCLinuxOS 2010 KDE
installed on it.

Backup Basics, Part 2: Using Clonezilla LiveBackup Basics, Part 2: Using Clonezilla Live

http://clonezilla.org/
http://clonezilla.org/downloads/stable/iso-zip-files.php
http://clonezilla.org/downloads/stable/iso-zip-files.php
http://en.wikipedia.org/wiki/I686


26

Download the ISO to a location somewhere on your
system where you can find it. I've downloaded mine
to /home/horus/ISO_Images/Clonezilla.org/, but any
convenient folder will do just fine. The download
process should look familiar after you have clicked
on the variant you want to use. Here's what mine
looks like in Firefox:

Note that the "Save File" option is selected. If that is
not the case when your download dialog opens, go
ahead and click that radio button to select it, then
click the OK button. Here's a picture of what you
should see next (at least on a KDE system):

Those of you astute enough to notice will see that I
have a previous version of Clonezilla Live already in
this folder. Instead of taking the shortcut of using this
older version (which still works just fine), I thought I'd
take the time to go get the latest version so you
could see how that's done. I did skip all the file
system browsing to get to this point, though. It's very
likely that you are going to choose a different place
to store your copy, anyway.
Once the Save button is clicked, the Save File
window closes itself, and a download window opens
in Firefox (or whatever browser you might choose
instead). You may safely browse elsewhere while
your download is going on, but you should wait until
the download completes to continue to the next step.
Those of you who are proficient in burning ISO
images may wish to skip ahead to the next topic 
Starting Clonezilla On The Target System.

Burning the ISO to a CD:
Use your favorite CD burning software to burn the
ISO file to a blank CD. Many choices exist: Brasero
and GnomeBaker for Gnome users, Xfburn for Xfce
users, K3b for KDE users, grafburn, bashburn, and
many others. It is presumed that you should already
possess the skills to burn an ISO to a CD, and it is
beyond the scope of this article to walk you, step by
step, through the CD burning process.
Note that the entire burn process should not take
very long at all, since the entire data load is about
130 megabytes. Now we are ready to start
Clonezilla Live.

Starting Clonezilla Live On The Target System:
I know everyone is eager to get started, but before
we jump in, there are some things I need to share
with you about using any imaging software:
Space Requirements  any image taken with
Clonezilla will be compressed, but it will still take up
space. Make certain the storage device being used
for the backup has plenty of room not just for the
image, but also to handle any temporary files
Clonezilla will generate during creation of the image.
Be Sure of Your Targets  on a Linux system, this
means you need familiarity with how your drives are
named, and with how Clonezilla will use this
information. Backing up a drive to itself (which would
destroy its current data set) seems to be impossible.
I tried it for research purposes and, yes, the system
prevented me from doing this, but the result would
still be a waste of time at best.
Read Carefully  I'll be taking us step by step
through the demonstration, but your system will
likely be different. Apply knowledge of your own
system to meet your needs and don't just blindly
follow along here. I will do my best to note places
where your system's setup needs to be considered
ahead of the screenshots so that the possibilities for
error are minimized. Take your time, read carefully,
and you should be fine.
Take Things In Order  please don't jump ahead of
the prompts that Clonezilla gives you unless you are
already an expert! Save any tricks and shortcuts
until after you have made a few successful backups
and recoveries. This is especially true when/if
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connecting external storage to be used for storing an
image.
Heeding these cautions will save you headaches,
folks. Not heeding them is almost certain to induce
them.

Configuring Your System To Boot From CD:
Now that the preliminaries are out of the way, the
next thing to be attended to is making sure your
system can boot from the Live CD. If your system is
configured to do this already, skip ahead to the next
section. (Most folks who run PCLinuxOS have
already figured out how to do this by now, but I've
covered the basics of where to go to refresh your
memory in case it's been a while.)
NOTE: You should probably go ahead and place the
Live CD in the optical drive during or shortly after
entering the BIOS Setup as described below. That
way, when the system restarts after exiting from the
BIOS Setup, it will boot from the Live CD without
further intervention on your part.
If you need to know how to do this part, you will
almost certainly have some reading to do, as
configuring your system to boot from an optical disk
is done from the BIOS setup, and is done differently
depending on what type of hardware you have
(making it difficult to cover all the variations in this
article). If you don't have a hard copy of it, you may
wish to locate a copy of your motherboard manual or
System Users Guide online and print the information
on your BIOS Setup for your reference. What you
will need to know (if you don't already) is:

What keystrokes are needed to cause your system
to shift into its BIOS Setup. Typically F2, F10, or
some other function key during the Power On Self
Test (POST) phase of system startup.
Which menu in the BIOS Setup is used to set up the
Boot Order for the system. In newer systems, Boot
Order has its own menu, but a lot of systems hide
this in the "Advanced" menu of the setup.
How commands are modified and saved in your
BIOS Setup screens. Typically, Page Up & Page DN
are used to change values, and F10 is used to save
and exit from BIOS, but check your system's
manuals for specifics on this information. Some
setup menus even have contextsensitive help, so
try that, too.
Armed with this information, you want to raise the
optical drive (CD or DVD drive) above the system's
hard drives in the boot order, and then save the
setup and exit from the BIOS Setup screen. Your
system will restart upon exit from the setup screen.

Booting From The Live CD:
Now that the system is configured to boot from the
optical drive, if you haven't already done it, insert the
Live CD into the drive and allow the system to boot
from it. If all goes well, you should sooner or later
see a screen resembling this one:
(Screenshots from Clonezilla.org, used with
permission.)

I generally accept the default setting since all my
gear does 1024x768 without a problem. If you need
to select a lower resolution, scroll using the down
arrow key to "Other modes of Clonezilla live" and
press ENTER. If you do, you will see a menu that
looks like this:
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From here, you may easily scroll down to a screen
resolution your system is capable of displaying. Now
would be a good time to mention that Clonezilla
does not use graphics to speak of in the default
mode  all the menus from here onward are ncurses
text menus. Using your keyboard to navigate is
simple enough, and more controlled than using a
mouse. Once you have selected a graphics
resolution and pressed ENTER, the system will go
through a textmode Linux startup, and, after that,
the next screens displayed will help you select any
special language and keyboard settings you might
need if English and the default keymap are not
suitable:
The Language screen:

See what I mean? No fancy pictures, nor any
graphics (save for "ASCII Art") to speak of, but be
advised that Clonezilla supports a fair number of
languages aside from English. Make sure you select
the right one before proceeding, or you will likely be

hard pressed to make sense of the screens that
follow. Next up is the keyboard map selection:

I generally don't touch the keymap, but if you are
using a keyboard that requires a special keymap,
here's your chance to select the right one for your
keyboard. See the instructions in the menu for more
details. Next up: actually starting Clonezilla. Here's
the screen for that:

Notice that you can get to a command prompt from
here. I've never actually done this, as the Clonezilla
mode does everything I've ever needed. I suspect
this option is there mainly for developers and more
advanced users.

Now we are finally going to start setting up the
imaging process (Hint: the instructions on this next
screen are worth a look on your first time through).
Here's what that screen will look like. Choose the
first option, deviceimage, to take an image of a
drive or partition.

Mounting the drive to which we will be saving the
image is next. The restore phase comes later:

The first option, local_dev, is the one to use for
sending an image to a USB device, or to another
drive on the same system. Note that other options
make it possible to use Clonezilla Live to send the
image over a network (e.g., to a file server or other
system), but that we will be doing a local backup to a
USB device. Once you press ENTER to choose this
option, a message displays at the bottom of the
screen prompting you:
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ocsrootdevice is local_dev
Preparing the mount point /home/partimag...
If you want to use USB device as a Clonezilla
image repository, please insert USB device into
this machine *now*.
Wait for about 5 secs then press Enter key so
that OS can detect the USB device and later we
can mount it as /home/partimag.
Press "Enter" to continue......
Plug in the USB device as instructed, and press
ENTER. This will bring up a fairly long list of USB
enumeration data showing that the system has
detected the device. The last message should show:
[ XXX.xxxxxx] sd 4:0:0:0: [sdb] Attached SCSI
disk
where XXX.xxxxxx is a number of some kind  I
honestly don't know what significance it has.). Take
note in the above line what appears where [sdb]
appears in the line above, as that information will be
useful to you in the next screen if you're following
along. Once a similar message to the above is
displayed and you know where the device you are
using is attached ([sdwhatever]) it is safe to press
ENTER to continue.
The next screen will allow you to mount the USB
device just attached to the system on
/home/partimag. Again, the instructions here are
definitely worth a look the first couple of times
through.
NOTE: in the case of my demo system, which only
has one SATA drive, the USB drive I'm using
attached as /dev/sdb, but in a system with more than
one drive the USB device may fall out farther down

the chain. This is why I recommended you read
where your own system attached the device in the
previous step.
Unhappily, I don't have screenshot of this particular
screen, and it's an important one. The instructions
are particularly relevant here, and state:
Now we need to mount a device as
/home/partimag (Clonezilla image(s) repository)
so that we can read or save the image in
/home/partimag.
///Note/// You should NOT mount the partition you
want to backup as /home/partimag. The partition
name is the device name in GNU/Linux. The first
partition in the first disk is "hda1" or "sda1", the
2nd partition in the first disk is "hda2" or "sda2",
the first partition in the second disk is "hdb1" or
"sdb1". . . If the system you want to save is MS
windows, normally C: is hda1 (for PATA) or sda1
(for PATA, SATA, or SCSI), and D: could be hda2
(or sda2), hda5, (or sda5)...:
sda1 12.9GB_ext4(In_ST9120822AS_)_ata
ST9120822AS_5LZ3NND8
sda6 103GB_ext4(In_ST9120822AS_)_ata
ST9120822AS_5LZ3NND8
sdb1 160GB_ntfs(In_HTS541616J9SA00_)_usb
Hitachi_HTS541616J9SA00_FFFACFF0FF000000
FB2404FFCFF9Fe0:0
Here we see in my list, sdb1 is my 160GB external
drive, (formatted NTFS so I can use it at work, too),
so I scroll down to sdb1's freakishly long entry and
press ENTER to continue.
The next screen lists the toplevel directories on the
USB drive, and asks which directory is for the

Clonezilla image. I have created a folder on this
device called Clonezilla which I will select by
scrolling down to it and then pressing ENTER to
continue. Any convenient folder will do, even the
root. Clonezilla creates a folder for the image within
whatever folder you select.
What is next displayed at the bottom of the screen is
a disk usage map so that you have a chance to
abort if you don't think you have enough space on
the target device. Checking the entry for /tmplocal
dev/Clonezilla I see it has 51 gigabytes free (more
than enough to house my freshly installed system),
and it is mounted on /home/partimag where it
belongs. I press ENTER to continue.
The next screen will show a choice between
Beginner and Expert modes. I'm willing to admit I'm
still a beginner here, but your mileage may vary (if
so, I wish you luck!). Choosing "Beginner" I press
ENTER again to continue.
Finally a screen for which I have a shot appears:

In this screen, we do not want to do a restoredisk as
shown  we want to do a savedisk. This should be
the default option for this screen, meaning the red
highlight bar will be over it. In any case, select
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savedisk and press ENTER to continue. Once we've
been through the demo, feel free to do a saveparts
to save partitions, but we're not doing that just now.
The next screen that displays will show the default
filename Clonezilla has chosen for your image. Mine
looks like: 2011051901img. Notice there are no
spaces, special characters, or other invalid stuff in
this folder name (that's what it is, really). The default
is the date in Japanese format (YYYYMMDD)
followed by a two digit number which naively
assumes we won't be making more than 99 images
in a single day. You can, of course, alter this, so I will
rename mine as follows:
2011051901CompaqV500PCLinuxOSimg
That's just so I can look at the image and tell a little
more about where it came from. I press ENTER to
continue, and I'm greeted with another screen
asking me to choose a local disk as the source (this
is the drive we'll be taking the image from). This
choice is easy for me: there's only one hard drive on
my system. If your hardware varies signficantly, do
the reading and make the choice that will yield the
desired result. Whatever you choose is about to be
imaged, and the image will be compressed and
stored on the target device you have previously
selected.
Pressing ENTER to continue (yeah, there's a pattern
here), I'm greeted with another screen asking if I
want the image checked for restorability. On your
first image, it is a good idea to do this, but it takes a
bit of extra time (so you'll have to decide for
yourself). I will opt to check the saved image and...
yeah, there's that ENTER key again.

A block of green text at the bottom of the screen
informs me that:
************************************************************
PS. Next time you can run this command directly:
/opt/drbl/sbin/ocssr q2 c j2 z1p i 2000 p true
savedisk 2011051901CompaqV500PCLinuxOS
img sda
This command is also saved as this file name for
later use if necessary: /tmp/ocs2011051901
CompaqV500PCLinuxOSimg201105190130
Press "Enter" to continue...
Yep, I'm in for a penny, in for a pound now. Pressing
ENTER this time scrolls by a bunch of text and stops
with a prompt at the bottom of the screen asking:
Are you sure you want to continue? ? (y/n)
If you press n now, you've just aborted the whole
thing and will have to start over if you intend to take
an image anytime soon. I press the y key to continue
taking the image, and follow it with ENTER.
A whole 'nuther bunch of text will scroll by rather
rapidly, at the bottom of which will be a status line
which updates the elapsed time, time remaining,
percent completion, and the data transfer rate. My
crummy little USB drive is doing 1.61 gigs/ minute!
The first partition (12.9 gigs, about 4.7 gigs of which
is used) is written in a little under two minutes. The
/home partition (which only has two gigs of data)
takes about a minute and 41 seconds. The
recoverability check proceeds automatically, one
partition after the other, and takes less than a minute
to complete both. Well worth it in my book!

The last message the system will send you is about
how to get out. The important part for now is:
************************************************************
When everything is done, remember to use
'poweroff', 'reboot' or follow the menu to do a normal
poweroff/reboot procedure. Otherwise, if the boot
media you are using is a wratable device
(such as a USB flash drive), and it's mounted,
poweroff/reboot in abnormal procedure might
make it FAIL to boot next time!
************************************************************
Press "Enter" to continue...
Yep, press ENTER again. Don't worry, we'll quit
before we wear out the ENTER key, hopefully. A
short menu at the bottom of the screen is displayed:
"ocslivegeneral" is finished.
Now you can choose to:
(0) Poweroff
(1) Reboot
(2) Enter command line prompt
(3) Start over
[2]
That [2] indicates that "Start Over" is the default
selection. Me? I'm going to select 1 to reboot the
system. Unmount messages and a rude little chirp
from the speaker let me know the system is
rebooting. When the drive tray pops open on the
CDROM, I retrieve the disk from the drive, shut the
tray door, and (for the LAST TIME, thank goodness)
press ENTER to continue.
That completes the process of taking a system
image of a disk. My "bare" PCLinuxOS KDE system,
(which weighed in around 6.7 gigs) compressed to
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just under a gigabyte! Wow, that's tight! (I know from
experience that this is typical of the "default"
compression used by Clonezilla, and is very
reliable.) This image could now be transferred to a
DVD for archival storage very easily.
The restore process is virtually identical to that which
we just completed except that restoredisk is selected
at the mode screen instead of savedisk, and the
prompts will ask for a source from which to read the
image data, which will be on the device and in the
folder where the image previously taken was stored,
and then for a disk to which this image will be
restored. Careful reading of the prompts (especially
with regard to the restore target) should get you
there safely.
Hopefully you can now play with this useful tool on
your own and make it a part of your personal backup
strategy. As you may have seen from this simple
introduction, it is a powerful toolkit and has many
more uses than I've outlined here. A word or two in
parting: the Clonezilla website has a rich set of
FAQs, and offers a mailing list and forums for
support from a very active community of users and
developers. Reading and getting involved there will
certainly enrich your understanding and help make
Clonezilla even more useful to you.
The next tool I hope to survey is luckyBackup, but
that's for next time. Until then, may all your backups
be recoverable!

Screenshot ShowcaseScreenshot Showcase
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Forum Foibles: Going HomeForum Foibles: Going Home

MP3 OGG

Going home to PCLOS
I mean home to the very best

Fun place where users go
To boot the night away

Can't wait to get on the line
Everything's gonna be so fine

Now that I'm on my toes
No more 'puter woes

Cool Forum
Where the best folks meet ya

Always roarin'
With their tux they'll greet ya

Download it now don't be shy
Give PCLOS a try

Tell everything else goodbye
Come home feel that high

Bootin' slowFeelin' lowNeed to goRight back where I belong

http://www.pclosmag.com/html/Issues/201106/files/goinghometopclos.mp3
http://www.pclosmag.com/html/Issues/201106/files/goinghometopclos.ogg
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Forum Foibles: Going Home

Welcome home to

PCLinuxOS! I'm thinking

you may be somewhat

disappointed, since

PCLinuxOS works so

well. Short of a hammer,

you may have trouble

breaking the computer.

Welcome home toPCLinuxOS! Get ready forsome smooooooth sailing!
Welcome home to the bestLinux distro!!! We're gladyou are here!

Welcome home! We're
glad you were lurking,

but even happier to have
you join our discussions

here!
Welcome home to

PCLinuxOS! It's not only
a great distro to "start"
your Linux journey with,
but also the best one to

stick with.

Welcome back home. Goodto have ya back home.Welcome back home toPCLinuxOS! We hope youstick around. Things justkeep getting better andbetter.

Welcome home toPCLinuxOS! I'm bettingthat it won't take you allthat long to get up tospeed with PCLinuxOS.
Welcome home toPCLinuxOS. We're happyto hear that you will bemaking this your new"digs" in the Linux world.

Welcome back to oursweet home, dude!

Thanks to Texstar, I
am back home.

Thanks to Texstar,
we're all home

Welcome home to
PCLinuxOS! Don't mind

the "steep learning curve."
It DOES get easier and
better. You'll soon find

things getting easier and
easier.

Welcome home to
PCLinuxOS! Don't worry ...

we all were once
beginners.

Welcome home! I'm glad
to hear that you find The

PCLinuxOS Magazine
worthy, as well.

Welcome home to
PCLinuxOS!!! You're
gonna like how we do
things around here!

A simple welcome home.

Welcome home. Yabin gone too long.
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by Paul Arnote (parnote)

There is another video tool in the PCLinuxOS
repository that you will want to have in your video
tool chest. AcidRip makes it very fast and easy to
rip your DVDs to AVI files. Written in Perl and Gtk+
2.0, AcidRip provides a graphical user interface to
the mencoder command line utility, and literally
provides one click transcoding from a DVD (if you
accept all of the default values).

When you first launch AcidRip, you will see
something similar to the screen shot above. The
window is divided into five tabs, where you can set
the options for the transcoding of your DVD movie,

as well as the options for how AcidRip behaves and
performs.
The first tab is called “General.” In the upper section
of the tab, you can label the title of the DVD track
you want to transcode, as well as the location and
name of the file. You can select between saving your
transcoded video file as either an AVI or MPG file. If
you are wanting to possibly store the video file on a
CDR, you can set the target size of the final
transcoded video file (700 MB). You can also specify
how many files you want to transcode the DVD to.
The advantage of this is that if you specify multiple
files, each targeted at a specific file size, you will
end up with video files that use a higher video
bitrate, which increases the overall quality of your
video images. The target file size option is disabled if
you lock the video bitrate setting in the “Video” tab.
In the middle section, “Audio,” you set the format
and bitrate of the audio track for your transcoded
video. MP3 audio, using mp3lame, at 128 kbps, is
the default, but you can select from FAAC encoded
audio, PCM (*.wav) audio, MP2 audio (via twolame),
lavc encoded audio, or to just copy the audio track
as is from the DVD.
The bottom section, “Other stuff,” allows you to
choose if you want to include subtitles with your
transcoded video.
The four buttons at the very bottom left of the screen
are static throughout all the tabs. The “Queue”
button adds titles from the DVD to a list of items to
transcode. The “Compact” button allows you to
switch between the compact view that appears when
you start the transcoding and the window presenting
the full view. The “Stop” button, stops the

transcoding, and appears as the “Start” button
before you begin to transcode your video. Naturally,
the “Quit” button exits AcidRip when you are finished
transcoding video.
Similarly, the right side of the AcidRip window is
static, as well. It lists the titles on the DVD in the
upper right, and lists a summary and progress bar of
the current job in the lower right.

Video: Part 8 - AcidRipVideo: Part 8 - AcidRip
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Under the “Video” tab, you make the settings for
your transcoded video. At the top of the tab window,
you select the video codec you wish to use. The
default is lavc, but you can also select from Xvid,
x264, vfw and qtvideo, as well as a couple of others.
You can also select how many passes you want to
make through the video. As we’ve mentioned before,
there is a huge advantage to using two pass
encoding, and the quality gain far outweighs the
disadvantage of taking twice as long to transcode
your video.
In the “Options” field, you can set or select any
mencoder command line options that you like. Refer
to the mencoder man files for more information on
how to use those command line options.
If you’ve set a target file size, the resulting video
bitrate will be shown in the bitrate entry, and you
cannot change the setting. It merely becomes an
“informative” entry, to let you know what video bitrate
will be used during the transcoding. However, if you
place check the “Lock Bits/Px” setting, as I have
done here, you will have full control over the video
bitrate, and the target file size entry changes to a
state where it cannot be changed. For my video
transcoding, I’ve opted to target a specific video
bitrate, allowing the file size to fall where it may.
The next section of the Video tab allows you to crop
your video image, if you feel it is necessary. Be
careful that your resulting video height and width are
evenly divisible by 16. Otherwise, you may end up
with a video file that may not play back properly.
If you want to change the output size of your video,
select the “Scale” check box. If you select the “Lock
Aspect” setting, setting either the height or the width

that you want will make the other default to a
proportional value. For my video transcoding, since
I’m converting the video for playback on my
Blackberry Storm, I want my video to be 480 pixels
wide. Fortunately, these are also the default values
for AcidRip.
The next settings, “Pre filters” and “Post filters,”
allow you to apply special filters for your transcoded
video. The default values are shown in the screen
shot. For what it’s worth, the “pp=de” setting is a
mencoder command that deinterlaces the video
before it is recorded to the video file.

Under the “Preview” tab, you can check to see if you
have selected the correct title from the DVD.
Checking the “Embed” setting causes the selected
DVD title to appear embedded in the AcidRip
window, which is also the default setting. If you clear
the check box, the preview will appear in a separate
MPlayer playback window. Selecting the “View”
button will also cause the DVD title selection to
appear in a separate MPlayer playback window,
regardless of the selection of any of the check box
options.
I found the “Flickbook” setting to not be very useful.
On my computer, at lest, the images flicker by so
fast that you can’t even tell what they are.

Video: Part 8  AcidRip
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Under the “Queue” tab, you can examine the
mencoder command line that is used to transcode
the selected title(s) from the DVD. If you want to
save these commands, or if you just want to take a
look at the mencoder command line used (say,
maybe you want to learn more about the mencoder
command line), clcking on the “Export” button will
allow you to save the output in the Queue tab to a
file.

The “Settings” tab allows you to select the options
that dictate how AcidRip runs. You can specify the
location of the Mencoder, MPlayer and lsdvd
application files, as well as the location to use to
store the cached files.
Of the options presented, there are only a few that
you are likely to find useful. I selected the “Autoload
media” option, so that the DVD is automatically
loaded when it is inserted into the computer’s DVD
player. The default value is unchecked. The other
three selected options are the default values for
AcidRip, and I have left them unchanged. Selecting
the “Revert” button will reset the settings to their
default values.
Once you have everything set up how you like it,
select the “Start” button. The window displayed on
the screen will change to one similar to the one

above. This window will keep you updated on the
progress and status of your video transcoding. The
really nice thing about replacing the main window
with this window during the video transcoding is that
it makes it much harder to accidentally stop the
transcoding process. To do so, you will have to
specifically switch back to the main window (by
pressing the “Full view” button), and then click on
the “Stop” button.

Summary
AcidRip lives up to its billing as being able to
transcode DVDs to video files with one click. For
most people, the default values will be more than
adequate. Of course, you can also tweak those
values to your heart’s content. Plus, the more you
understand about how mencoder works, the more
you’ll be able to milk out of AcidRip.
Basically, if MPlayer can play the DVD, then AcidRip
can transcode that DVD to a video file. Initially, I tried
AcidRip with my DVD copy of the latest Star Trek
movie. I was beginning to think something wasn’t
working properly with AcidRip, until I tried playing the
DVD. In fact, Phoenix wouldn’t even mount the DVD
when I placed it in the DVD player on two different
computers. After further investigation, I discovered
that even MPlayer couldn’t play the DVD,
presumably due to the copy protection scheme used
on the DVD. After choosing a different movie
(Idiocrocy, from Mike Judge), everything worked as it
should.
Often overlooked, AcidRip deserves a prominent
place in your video tool chest.

Video: Part 8  AcidRip
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by Darrel Johnston (djohnston)
First things first. I have some corrections to add to
the previous articles.
In Part 1 I said, "Most who used Amiga computers in
the 1970s and 1980s came to love the capabilities of
the machines." According to the Amiga History site,
"The Commodore Amiga was officially launched in
September 1985 for £1,500." Hey, I was only off by a
decade! I can remember where I was when
President Kennedy was shot, but my memory
sometimes fails me spectacularly in other ways. Had
I done basic research, I would have caught that
blatant error. Stuff happens. My apologies to
nimrod7 on the Amigaworld forum, and to any others
who caught that error. So, if you were running an
Amiga in 1975, you were ten years ahead of your
time!

Next, in Part 1 I said, "binaries already compiled for
AmigaOS will not run, even if they are compiled for
the same family of CPU." According to HenryCase,
also on the Amigaworld forum, (and the AROS
EXEC forum), that is incorrect. As Henry states,
"This simply isn't true, as can be seen with all the
68k Amiga software that runs on AROS 68k." In
other words, much of the Amiga software written for
the Motorola 680x0 CPUs will also run unmodified
on the 68k version of AROS. This was also pointed
out by Tzimisce on the AROSEXEC forum.

In Part 2 I said, "The messaging system of
AmigaOS's Exec library is very fast and flexible,
based originally on Tripos." According to Wikipedia's
AmigaOS article, "In AmigaOS 1.x, the AmigaDOS

portion was based on TRIPOS, which is written in
BCPL. Interfacing with it from other languages
proved a difficult and errorprone task, and the port
of TRIPOS was not very efficient. From AmigaOS
2.x onwards, AmigaDOS was rewritten in C and
Assembler, retaining full 1.x BCPL program
compatibility, and it incorporated parts of the third
party AmigaDOS Resource Project[3], which had
already written replacements for many of the BCPL
utilities and interfaces." So, only AmigaOS version
1.x's version of DOS was based on TRIPOS. A
better explanation, as pointed out by HenryCase,
comes from http://www.thule.no/haynie/caos.html:

"As most of you know, AmigaDOS was not the first
choice for the toplevel OS/DOS on the Amiga
computer. What we now call AmigaDOS was really
the backup DOS, based on an already existing OS
known as Tripos (developed at the University of
Cambridge Computer Laboratory by the TRIPOS
Research Group, and converted with amazing speed
by Metacomco's Dr. Tim King and his band of
programmers). When the original, intended,
designedfortheAmiga DOS failed to materialize (in
what would no doubt be an interesting story in itself),
the Amiga was launched with AmigaDOS, and the
rest is history, so to speak....
CAOS was always meant to be built on top of Exec
(in much the same way that AmigaDOS is built on
top of Exec)."

HenryCase goes on to explain, "Essentially what
happened is that Exec was written inhouse by Carl
Sassenrath and the spec for the rest of the original
OS (CAOS) was given out to an external team to
code. This external team didn't deliver on time, so

the code from Tripos was grafted onto Exec to make
AmigaDOS. Exec is the only component (AFAIK)
that is left from the original OS design. I still think it's
a massive shame we never got CAOS."
The subject of this article is installing JanusUAE to
the Icaros desktop. As stated previously, UAE is an
Amiga emulator, written to run Amiga programs on a
nonAmiga, although there is a version of UAE
written for the Amiga. (Go figure.) JanusUAE was
written to run on AROS, and is currently at version
0.8. The AmigaForever's UAE installation defaults to
800x600 screen size, but is really too small to do
any justice to Amiga's Workbench. Knowing that I
wanted to run JanusUAE at a screen size of
1024x768, I chose to enlarge Icaros's screen size
from 1024x768 to 1152x864. A simple edit of the
grub.cfg file resulted in booting to an Icaros VESA
desktop of the new size. Icaros automatically
changed its Screenmode Preferences to the new
screen size.

First, I attached the AmigaForever CD to VirtualBox.
After starting Icaros, I selected My Software >
AmigaApps > SetupAmiBridge from the menu. This
launches a set of scripts to install JanusUAE.

Alternate OS: Icaros, Part 4Alternate OS: Icaros, Part 4

http://www.amigahistory.co.uk/ahistory.html
http://amigaworld.net/modules/newbb/viewtopic.php?topic_id=33292&forum=28&13
https://secure.wikimedia.org/wikipedia/en/wiki/AmigaOS
http://www.thule.no/haynie/caos.html


38

In the SetupAmiBridge window, the AmigaForever
CD is listed as a source, and I chose it.

Clicking the AmigaForever button launches an IconX
window which shows the files being copied. The files
were copied so quickly, I only managed to get a
screenshot of the last two copied. The scripts make
a complicated task very simple.

After installation, a window shows two steps needed
to enable coherency mode. This is the same as
"seamless" mode in VirtualBox. You can make
JanusUAE share the Wanderer desktop with Icaros.

After installation is complete, a new icon is added to
the menu to launch JanusUAE.

After launching, we see the preconfigured
AmigaForever's UAE Workbench desktop in

800x600x4 resolution. (bottom center) 4 bits is only
16 colors, but the default resolution should be 16
bits, which is 256 colors. No problem. Using the
ScreenMode button at the bottom of the screen, we'll
change this.

There are many graphics modes offered, including
standard Amiga NTSC and PAL ones. We'll use the
uaegfx driver with a resolution of 1024x768x32 for
full color. After choosing, press the Save button.

Alternate OS: Icaros, Part 4
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The screen has reset, but we lost the program
launcher bar at the bottom of the screen. (bottom
right, previous page) We're running an emulator
inside an Icaros window, so we'll just close the
window and start JanusUAE again.

All the drive icons are lined up nicely on the desktop,
and we have our program launcher bar back again.
The SetupAmiBridge scripts have set up UAE
drives, (Ram Disk, Work and AmigaOS), as well as
shared AROS drives. The bottom (active) window
shows the contents of the AmigaOS:WBStartup
drawer. Any commodities (memory resident
programs) desired go here, and are loaded when
Workbench starts. (bottom left)
The first program button on the left is for AWeb, an
older web browser. Pressing the button, we get the
AmigaForever documentation by default. Trying to
open Google's main page resulted in a meditation
guru screen. You won't see that from AROS. This
could be a result of running an emulator within an
emulator, incorrect settings, or an incomplete setup
between the Icaros host and the JanusUAE client.
Whoops! Time to close JanusUAE and start again.

Running the DirectoryOpus program from the
JanusUAE program launcher bar gives us a
completely different desktop interface than
Workbench.

I tried a couple of programs from my Amiga
magazine CDs, and they both worked. I didn't
attempt anything that is graphics intensive. It's time
to close JanusUAE, and the proper way to do it is by
pressing the last button on the right of the program
launcher bar, (UAEConfig). Click the Quit UAE
button to exit.

Alternate OS: Icaros, Part 4
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Before closing this last article on Icaros, I'd like to
mention a new enhanced version of AROS, AROS
Broadway, for three reasons. First of all, it has a
different program launcher called Quickstarter. It
expands both vertically and horizontally to give quick
access to selected applications.

Second, it implements a multi
user system, using a setup tool
called Login.

Last, but not least, not only are
desktop icons implemented, the
broadwayguide icon launches a
short video tutorial. (top center)

Icaros does, indeed, have the same capabilities. It's
just that AROS Broadway has implemented them
"out of the box".

Alternate OS: Icaros, Part 4

International Community
PCLinuxOS Sites

Netherlands

Turkey

Denmark
Czechoslovakia

Italy

Poland

http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://www.aros-broadway.de/
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by Patrick G Horneker (phorneker)

This article discusses command line utilities that
WindowMaker uses to perform its magic on your
desktop. In order to further explain WindowMaker's
capabilities, it is necessary to explain the internal
workings of the window manager. This will also help
when it comes time to explain how to create themes
for WindowMaker.
The actual programs that make up WindowMaker
itself are where one would expect to find them, in
/usr/bin.
Obviously, wmaker is the program that starts up
WindowMaker itself. Like any window manager such
as metacity (for GNOME), kwm (for KDE), or FVWM
(now in the PCLinuxOS repository), wmaker is the
main control program for the display of windows,
menus, icons, docks, and the overall user
experience that WindowMaker provides.
But there is more to WindowMaker than just
wmaker. There are a number of supporting
command line utilities and dock applications that are
included with the WindowMaker package.
startwindowmaker is a script that launches all
components of WindowMaker first, then wmaker
itself. When you select WindowMaker from the
Session menu at the login screen, this is the script
that gets executed when WindowMaker is launched
after you login to PCLinuxOS.
WindowMakerTerminal, (or wterm), is
WindowMaker’s equivalent to KDE’s Konsole, or
GNOME’s Gnome Terminal. wterm does not have

the customization features available on Konsole or
GNOME Terminal, but it does give you a command
line interface to your PCLinuxOS system..
getstyle can be used to save WindowMaker’s state
for the appearance of windows (called display
attributes), a component that is part of
WindowMaker themes. setstyle is used to change
the appearance of windows using a text file
(containing the display attributes, usually saved with
the getstyle command.) Typically, we would call
getstyle and redirect the output to a file to save the
current set of display attributes, for example:
getstyle >pclinuxos.style
I used the .style extension in this example so that
anyone would know the contents of this file define a
style that WindowMaker uses. Also, this is the official
extension used by the developers of WindowMaker
for their set of styles included in the default
installation. For PCLinuxOS, these files are stored in
/usr/share/WindowMaker/Styles and in
/usr/share/WindowMaker/Themes.
The following is the default style as supplied with the
PCLinuxOS implementation of WindowMaker. (lines
spaced out for clarity)
{
LargeDisplayFont ="sans:pixelsize=80";
HighlightColor = "#5b67b2";
MenuTextExtendSpace = "1";

FTitleColor = "#eeeeee";
MenuTitleExtendSpace = "1";
MenuTextFont = "sans:pixelsize=12";
UTitleBack = (mdgradient, "#e9eae9","#e0e1e0", "#dbdcdb");
IconTitleFont = "sans:pixelsize=10";
PTitleBack = (mdgradient, "#000000","#8c8c8c", "#aaaaaa");
WindowTitleFont ="sans:bold:pixelsize=10";
UTitleColor = "#000000";
MenuDisabledColor = "#a4a4a4";
ClipTitleFont ="sans:bold:pixelsize=10";
MenuStyle = flat;
MenuTextBack = (solid, "#e6e7e6");
PTitleColor = "#000000";
IconBack = (mdgradient, blue,"#bfbfbf", "#e6e7e6");
MenuTitleBack = (mdgradient,"#5772b4", "#415faa", "#2b4da0");
DisplayFont = "sans:pixelsize=10";

WindowMaker on PCLinuxOS: WindowMaker Internals, Part 1WindowMaker on PCLinuxOS: WindowMaker Internals, Part 1
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FTitleBack = (mvgradient, "#5772b4","#415faa", "#2b4da0");
WindowTitleExtendSpace = "1";
TitleJustify = right;
CClipTitleColor = "#a4a4a4";
ResizebarBack = (solid, "#8c8c8c");
MenuTextColor = "#000000";
ClipTitleColor = "#000000";
IconTitleBack = "#2b4da0";
HighlightTextColor = "#ffffff";
IconTitleColor = "#ffffff";
MenuTitleFont ="sans:bold:pixelsize=10";
MenuTitleColor = "#eeeeee";

}

wkdemenu.pl is a Perl script that reads in the
current menu configuration from the KDE desktop.
The PCLinuxOS implementation of WindowMaker
uses this script to get a list of applications to create
the user menu. It accomplishes this by setting up an
external menu which is called to retrieve the listing
of applications available in the KDE installation.
Then, any additional applications it finds will be
inserted into separate menu entries. Warning: The

script itself has not been updated since September
2001!!!
The current version of WindowMaker has been 0.92
since 2008. Unfortunately, wkdemenu.pl
implements the user menu in a format that is
compatible with versions earlier than 0.90.

While WindowMaker can use menus in the older
format, converting the generated menu to the new
format using wmoldmenu2new will prevent
PCLinuxOS from updating the menu when software
is added to or removed from the system using
Synaptic. You may use wmoldmenu2new if you
wish to manually edit the WindowMaker system
menu when you add or remove software with
Synaptic. This utility is used by the WindowMaker
Configuration Utility and by WindowMaker
Preferences (Prefs.app).
wmCalClock is a 64x64 pixel application that
displays the date and time in the WindowMaker
dock. It is located directly below the Dock icon. This
application starts when you launch WindowMaker.
wmagnify is a WindowMaker application that
magnifies a small portion of the display where the
mouse pointer is at. This is an accessibility tool
provided with WindowMaker.
wmaker.inst is executed when WindowMaker is run
for the first time. This initializes the
GNUStep/WindowMaker directory in your home
directory where your personal preferences are
stored (as well as your custom backgrounds and
themes).

msetbg is a command line utility that sets the
background on your current workspace. Of course,
you will need to supply various options with this
utility, depending upon the type of background you
wish to set. wmsetbg is typically called with a set of
common options.
a or maxscale scales the specified image
preserving its aspect ratio. This could result in part of
the background color showing where the image
does not cover the screen.
b or backcolor sets the specified color and if an
image or another color is used, the color becomes
part of a texture implemented with the background.
e or center centers the image specified in the
command line.
t or tile tiles the image specified in the command
line.
Note: e and t should not be combined. It really
does not make much sense.
s or scale scales the specified image. This can be
combined with either e or t.
d or dither dithers colors. At least two colors must
be specified with this option.
w or workspace selects which workspace to
change the background.
The t, e, s and a options require a filename for
the image you want to use as a background.
The b and d options require that at least one color
be specified in either a UNIX recognized color name
(which is the same as the color names used within
HTML tags, and on CSS stylesheets), the
“#RRGGBB” format (quotes included here), or
“rgb:RR/GG/BB” (quotes included here also) where
RR, GG, and BB are hexadecimal values.

WindowMaker on PCLinuxOS: WindowMaker Internals, Part 1
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For example, wmsetbg b “#7f7f7f” or wmsetbg b
“grey50” will set a 50 percent grey background in
the current workspace.
Likewise, wmsetbg e s mybackground.jpg will fill
the background with whatever picture is in
mybackground.jpg.

There are other command line utilities provided with
the PCLinuxOS implementation. These are typically
called from applications written specifically for
WindowMaker, and are not directly called from a
command line. Some of these applications are
downloadable from Synaptic, while others are
available from http://www.dockapps.org. Typically,
these applications have names that begin with “wm”
(for WindowMaker), and you can find them by
searching “windowmaker” from within Synaptic.

The getstyle and setstyle commands use a text file
containing display attributes, or properties that are
used by WindowMaker to display windows, icons,
menus, the Dock and Clip, and the background of
each Workspace on your desktop.

Notice that the overall text file generated by the
getstyle command is in a format similar to a CSS
stylesheet or a fragment of code in a language such
as C, C++, Java or Python. This format is called a
Property List in WindowMaker terms. Property Lists
are one of the core components of WindowMaker
itself, and the developers of WindowMaker created a
separate library and API package for that purpose
(called libPropList, and that package is available in
the PCLinuxOS repositories). Though it is not

required for WindowMaker itself, you will need the
libWindowMakerdevel, libPropList and
libPropListdevel packages if you wish to develop
applications for WindowMaker with PCLinuxOS.
This display attributes file is an example of a
Property List used to configure your WindowMaker
desktop. Each attribute has at least one parameter
which must be set.
Color parameters are notated as “#RRGGBB”,
“rgb:RR/GG/BB” or a named color as described for
the wmsetbg command.
Font parameters are notated as
“name:attribute:pixelsize=size” where name is
the name of the font, and size is the font size in
pixels. Quotes are included with the parameter so be
sure you include them. sans means the generic
sansserif font, which is the default font for the
PCLinuxOS implementation, and it is used if
WindowMaker cannot find the font you request. The
font size is expressed in pixels rather than points.
This is because computer displays are measured in
pixels on the screen rather than points on the printed
page. attribute is optional, and does not need to be
included if you are using the normal variant of the
font. If you wish to use a bold font, for example, a
bold sansserif font, you would notate the font as
“name:bold:pixelsize=size”. For an italic font, you
would notate the font as
“name:italic:pixelsize=size”.
You can also give WindowMaker a choice of fonts to
use. For name, use a comma separated list of fonts
that WindowMaker can use in order from first choice
to an “if all else fails” choice.

If you have ever programmed in a functional
language such as LISP or SCHEME, you will notice
that the parameters in a Property List are either
constant, quoted values, or a list of parameters
enclosed within parentheses. This is because some
of the display attributes in the generated text file
require multiple parameters to be set at once.
Fortunately, these parameters are also set when you
use either the WindowMaker Configuration Manager
(wmakerconf) or the WindowMaker Preferences
utility (Prefs.app).

WindowMaker on PCLinuxOS: WindowMaker Internals, Part 1
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by Efstathios Iosifidis (diamond_gr)

Last month, on May 7th and 8th, the annual
conference of FOSS communities and projects,
called FOSSCOMM, was held in Patras, Greece.
FOSSCOMM 2011 was organized by the Patras
Linux User Group (PLUG) and the Computer
Engineering & Informatics Department (Laboratory
of Computing/Computer Center), University of
Patras. Most of the visitors were satisfied with the
whole organization, although there were some
technical issues due to the electricity blackout on the
morning of the second day.

There were 74 presentations, and some of the
speakers were from abroad. There were 662
electronic registrations, but only 453 visitors could
make it. The Enlightenment, Gnome, Fedora and
OpenSUSE communities were present with booths
full of people, happy to inform visitors about their
projects. Also a FOSS blog writer was there with a
booth, and they distributed PCLinuxOS CDs with
KDE, Gnome and E17.
Since this is a FOSS conference (meaning that most
of the visitors know their interest), technical
presentations were the ones most attended. There
was lots of information about computer systems’
security and development, and there is a lot of
serious development going on in Greece in many

areas of FOSS. FOSSCOMM is an opportunity for
everyone to present their work.

But what is a FOSS conference if the participants
and the visitors don't have a great deal of time? The
openSUSE team decided to throw a small release
for the new OpenSUNE 11.4. It is not a typo,
someone made a mistake on the cake. But where is
the fun if mistakes like that don’t happen? Some
guys from chanialug and osarena decided to join
the party.

An openSUSE team member with the
misspelled cake.
For more information, you can visit:
Web page:
http://patras.fosscomm.gr/
Presentations:
http://patras.fosscomm.gr/presentations/
Videos of presentations:
http://blip.tv/fosscomm2011

Some PCLinuxOS Live CDs were made available to
conference attendees.

A sampling of some of the freebies, a.k.a. "swag," given
out by the Firefox folks.
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Check out some of the pictures from the conference,
below.

The conference hall.

The Rio Antirio Bridge at night, near the University of
Patras.

A group photo of the conference attendees and organizers.

The RedHat “ambassadors.”

Some of the conference attendees give their attention to
one of the many presentations.

The Fedora “ambassadors.”
The next event in Greece is the FOSS conference,
from May 20th to May 22nd. For more information (in
Greek), visit http://conferences.ellak.gr/2011/.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

FOSSCOMM 2011: Patras, Greece

http://pclosmag.com/html/sorted.html
http://www.oneclicklinux.com
http://www.distrowatch.com
http://pclinuxos.com/?page_id=184
http://conferences.ellak.gr/2011/
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by Meemaw
Let’s continue our look at programs that are mainly
photo viewers.
eog  Eye of Gnome
According to Synaptic, “Eye of Gnome is meant to
be a fast and functional image viewer as well as an
image cataloging program.” You can view your
photos, see the camera settings information (exif)
and even send them by email with the help of the
extra plugins and a little configuration.

The exif information is visible if you View the
Sidepane, and your collection appears across the

bottom of your window by clicking View > Image
Collection. In addition, you can click View >
Slideshow to play your slide show.
Blue Marine
From the blueMarine web site:
“An open source application for the digital photo
workflow, the blueMarine project will provide you an
allinone tool for managing your photos, from the
shoot up to the archiving and beyond. blueMarine is
an expandable, open platform and includes specific
support for different photographers communities, as
well as the latest technologies.”
Upon first opening of blueMarine, the program will
guide you through some preliminary operations:

1. It will designate its workspace
/home/you/Pictures/bluemarine/MyPhotos.bmw
creating a hidden file for it’s own use,

2. Allocate memory  how much memory you want
it to access and,
3. Reopen  will then close down and restart the
program.
When it restarts, you will see a message on the
startup screen that this is a beta version. You can
close that screen using the x at the bottom of the
message. The you will see the directory tree on the
left. Navigating to the directory you want and clicking
on Tools > Build Thumbnail will result in the
thumbnails being generated. (next page, top left)
There seem to be several things you can use; the
toolbar at the top has (L to R) File Explorer,
Calendar Explorer, Catalog Explorer, Gallery
Explorer, and Trip Explorer. The star allows you to
give your photos a rating from 1 to 5, the checkmark
allows you to mark a photo as a favorite, and the X
deletes it from the workspace/computer. You can
toggle back & forth between the thumbnail view and
single photo view using the icons at the right of the
toolbar.

Photo Viewers Galore, Part 2Photo Viewers Galore, Part 2

http://bluemarine.tidalwave.it/
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The filmstrip icon turns the filmstrip at the bottom on
and off. The globe at right is the map explorer, which
gives you a choice of two NASA programs
(WorldWind and Blue Marble) plus OpenStreetMap
to view. The NASA programs seem to display really
slow. Actually, I couldn’t get either one to display at
all (using e17 in VirtualBox).
To me, blueMarine is kind of hard to use, but maybe
it’s just that it wasn’t working well for me and I
couldn’t seem to do what I wanted with it. It wouldn’t
work on my home computers at all. Honestly, I think
that there is too much extra stuff for just a photo
viewer, and they should have spent more time on
the viewer part to make it work better.
viewnior
This is a very simple, easytouse viewer. You
simply open the photo you want to look at. When
you choose View > Properties, you get a popup
window with a few of the statistics of the photo; File
Location, Name, Type, Size (of the file), Width and
Height.
Unlike some of the
simple viewers we
have looked at,
viewnoir has a crop
feature. When you
choose Crop Image,
you get a smaller
window with the
dimensions of your

picture. You simply adjust the numbers or the arrow
keys to designate the x and y coordinates of the
picture you want. The white lines will show you
where your borders will be. When you get the lines
where you want them, simply click on “Crop.” If you
change your mind instead, you can click on
“Cancel.”

kuikshow
It is a viewer which looks a lot like
Konqueror. When you open it, you
see a file managerlike window
where you can open a folder or
image. I have found that it will do a
few simple edits, such as brightness
and contrast correction. It will also
flip and rotate photos, and can also
do a slide show.

Photo Viewers Galore, Part 2

Top  thumbnails; Center  Blue Marble map;
Bottom  toolbar
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Simply doubleclick on the file you want to view and
it will open in another window.

From the
configuration
window, you
will find a list
of keystrokes
you can use to
do some
simple editing:

There is also a
rightclick
menu of the
same thing if
you would
rather use your
mouse:
You can start
the slideshow
from File >
Start
Slideshow.

Next month we’ll start looking at viewers that have
even more features.

Photo Viewers Galore, Part 2

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

http://www.pclinuxos.com
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ms_meme's Nook: Oh Give Me A Homems_meme's Nook: Oh Give Me A Home

MP3 OGG

Oh give me a home where the blue bull doth roam
And users in the Sandbox do play

Where files don't get lost and there is no cost
On my desktop a beautiful display

PCLOS is my home
To Texstar my thanks I bestow

Download it now I'll show you how
Never again will your 'puter be slow

Oh come on home never again do roam
To PCLOS it's the best

It's the top of the pack you'll always come back
After you've tried all the rest

PCLOS is your home
Give thanks to Texstar for the deal

Don now your specs write out those checks
And see how good you will feel

http://www.pclosmag.com/html/Issues/201106/files/ohgivemeahome.mp3
http://www.pclosmag.com/html/Issues/201106/files/ohgivemeahome.ogg
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by Paul Arnote (parnote)

How many times have you been cruising around on
web sites and come across an image that is
displayed way smaller than it should be, displayed
so small that you can barely tell what it is? Or how
many times have you looked at an image in your
web browser and wished that you could zoom in on
some detail in that image, without having to
download the image? Or how many times have you
received an image in your email that was too large
to be displayed in the available window space?

Thanks to Image Zoom, by Jason Adams, you can
enlarge or shrink images right there in your Firefox
browser window. It also works equally well with
Thunderbird and SeaMonkey. Released under the
GNU GPL v2.0 license, Image Zoom has been
around since July, 2004, with the release of Image
Zoom 0.1.2 for Firefox 0.9. Since then, there have
been 18 subsequent release updates, and it is
currently at version 0.4.6, updated most recently to
work with Firefox 4.x and beyond.

How it works
Image Zoom is actually one of those Firefox Addons
that is very simple. Right click on an image, and
select the level of magnification that you want to
apply to that image. Select more than 100%, and the

image will be enlarged. Select less than 100%, the
image will be shrunk down.
As simple as it is, Image Zoom is quite
customizable.

Customizing Image Zoom
First, open up your Firefox Addons box or page,
scroll down to “Image Zoom” and select the
“Preferences” button.

Under the General tab, you can specify how Image
Zoom behaves on your computer. The values

displayed above are the default values. Here, you
can change mouse button assignments, and select
to use the scroll button on a mouse to zoom images
(by selecting the check box).

Under the Zoom Context Menu tab, you can select
where menu items appear – either in the top level
menu, or in the submenu. Simply place a check
next to the items you want displayed. Checking any
of the items in the first menu list (left) places those
items in the top level context menu, while checking
the items in the second menu list (right) places those
selected items in the submenu.

Firefox Add-ons: Image ZoomFirefox Add-ons: Image Zoom

https://addons.mozilla.org/en-US/firefox/addon/image-zoom/
https://addons.mozilla.org/en-US/firefox/addon/image-zoom/developers
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Similar to the Zoom tab, the Rotate Context Menu
tab allows you to specify if the rotate menu items
appear in the top level menu (left menu list) or in the
submenu (right menu list).

The screen shots above show how the Image Zoom
menu items appear in the context menu of my
Firefox 4.0.1 web browser.

Summary
Jason Adams asks for a $2 (U.S.) donation if you
find Image Zoom to be useful to you. In my
estimation, it’s worth that and more. In fact, Image
Zoom is one of the first Firefox Addons that I install
whenever I do a new installation on any computer,
and I’ve used it since it first appeared. It has saved
me lots of time over the years, eliminating my having
to download the image and then enlarge that

particular image in an image editor. It’s small (78 KB)
and unobtrusive, quietly waiting in the wings for
whenever you need it.

Want To Help?Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
Join us on our Google Group mailing list.

Firefox Addons: Image Zoom

http://www.enkiconsulting.net/
http://groups.google.com/group/pclinuxos-magazine
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by Daniel MeißWilhelm (Leiche)

When you read the articles Get Slick With
xbindkeys, and Wbar: A Mac OSX Like Quick
Launch Bar, you can get some tips about how you
can use these two excellent programs in harmony.
I use xbindkeys now for all my shortcuts keys. I like
to click only two keys to open Clementine, set my
sleep timer to shutdown my notebook, or start
Screenie to take a screen shot of my desktop.
One thing is, if you add a new shortcut, you must kill
xbindkeys, and after you add your shortcut, restart
xbindkeys in order to use the new shortcut.
Here comes wbar, which will help us to do this.
The new wbar version 2.1.1 comes included with the
wbar config, and the icon looks like this:

Clicking on it, you get a new window (top image,
next column).
To add a new icon starter, click on .
A new window, like that below (second image, next
colum), appears:

Type in the Title field the name of your new icon
starter, such as the sample Tastenkürzel.
The command could be something like this:
killall xbindkeys | medit$HOME/.xbindkeysrc && xbindkeys

What does this command do?
killall xbindkeys stops xbindkeys. Now your
shortcuts will be gone.
medit $HOME/.xbindkeysrc opens the hidden
config file xbindkeysrc in your home directory.
As well as medit, you can use kwrite, gedit or
whatever your editor of choice is.
&& xbindkeys will start xbindkeys, after we have
stored and closed our editor.
Last, we need an icon. Without an icon, wbar will not
display our new starter.
I use/usr/share/icons/gnome/48x48/apps/gnomesettingskeybindings.png

Save it, and click on reload to display the new icon
starter.

Xbindkeys: Stopping, Editing & Restarting With wbarXbindkeys: Stopping, Editing & Restarting With wbar
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If you click on this icon, xbindkeys will stop, and your
specified editor will open the xbindkeysrc config file.

If you create a new shortcut, and close your editor,
xbindkeys will work fine again, with a new key
binding.
The only problem is that the command on the main
window of wbar will display the wrong command. I
don’t know why this happens, but it works.
Enjoy the new wbar.

Screenshot ShowcaseScreenshot Showcase

Come
Join Us!

Xbindkeys: Stopping, Editing & Restarting With wbar

Posted by Archie, May 25, 2011, running KDE 4.

http://pclosmag.com/forum/index.php
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by Gary L. Ratliff, Sr. (eronstuc)
If you make the same mistake as I did and try to say
this as “what five,” then you are apt to be misled as
to the nature of this language. However, if the IV is
taken correctly to be roman numerals, then you get
the correct idea that this is a FORTRAN IV compiler
from the University of Waterloo. This is the same
firm that created the language suite for the
SuperPET computer system from Commodore. I
mentioned in my coverage of FORTRAN in an
earlier article in this series that FORTRAN was my
initial language, and I took a course in FORTRAN IV
at Delta State University in 1970. The feature which
made this system unique was the extensive
debugging features this version offered.
Watfiv descended from the Watfor family of
languages. The University of Waterloo also
developed a COBOL system called Watbol. A review
of the language systems in Wikipedia points out that
the there was a major difference in the programming
styles of businesses developing FORTRAN
applications, and students developing code for
computer science course assignments. The early
FORTRAN implementations required a three step
process of compile, link, and execute. The systems
developed from Waterloo combined this all into one
operation, which was more useful for students who
were more apt to develop code with errors.
The University of Waterloo developed systems for
the IBM 260, and later IBM 370, as well as the PDP
11 and other computer operating systems. The first
version of Watfiv began to be used in 1968.
Various additions to the language were added. A
system of structured programming languages was

added, and the series had this feature
noted by being called Watfivs, Watfors,
and Watfor11s, which was for the PDP11
version of the system.
The set of compilers was widely adapted
by many universities in the United States
and Canada. The University sold
several hundred thousand of these
implementations.
It has been noted that computer courses
in Watfiv were still being taught at the
University of Mississippi as late as 1995.
As I mentioned in the articles on
FORTRAN, the language was set up by
punching lines of code into an 80 column
Hollerith card. The set which the student
presented was combined with a deck of
control cards for the computer system
upon which it was intended to be run,
and this was sent to the computer. Some time later,
the printout of the run – or the printout of the
garbage generated by an incorrectly entered
program – was presented to the student.
That the Waterloo languages could greatly simplify
this process accounts for its popularity in a teaching
environment.
If you desire to learn the details of the Watfiv
language, along with all the details involved in
creating a set of job control cards, there is a file
which may be downloaded called: watfiv.tgz, which
can be easily expanded into a manual for the
language in pdf format. In addition, the file contains
two IBM JCL tools and a tape image.

The above shows the first part of the table of
contents for the user manual.
At this time, I should apologize for taking so long to
get on with the series. However, my wife passed
away in the early part of 2010. Then my older son
(Gary II) was shot and disabled at the house, leaving
me to take care of him for several months. I got to
the point where I lacked the time and the desire to
continue writing.
However, in February he received a clean bill of
health, about as clean as can be expected for one
who has a metal tube running through his leg. Next
time, we will be covering the XML markup language.

Computer Languages A to Z: WatfivComputer Languages A to Z: Watfiv

http://www.jaymoseley.com/hercules/download/zips/watfiv.tgz
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A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Your Community Projects Forum

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

mailto:pclinuxos.mag@gmail.com
http://pclinuxos.com/?page_id=7
http://www.pclinuxos.com/?page_id=184
http://pclinuxos.com/?page_id=188
http://pclinuxos.com/?page_id=213
http://pclinuxos.com/?page_id=215


56

More Screenshot ShowcaseMore Screenshot Showcase

Top left: Posted by
jcolyng, May 28,
2011, running
KDE4.
Top right: Posted
by T6, May 11,
2011, running
KDE4.
Bottom left: Posted
by djohnston, May
7, 2011, running
LXDE.
Bottom right:
Posted by
coffeetime, May 24,
2011, running e17.






